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In the function CalculateEstimands, the placeholder “Your code goes here” needs to be 
replaced with lines for evaluating the estimands called “direct”, “indirect” and 
“difference”. We start by writing Visual Basic code for computing the direct effect. In 
the following figure, we have already typed part of a Visual Basic statement: 
estimand(“direct”) .value =.

We need to finish the statement by adding additional code to the right of the equals (=) 
sign, describing how to compute the direct effect. The direct effect is to be calculated 
for a set of parameter values that are accessible through the AmosEngine object that is 
supplied as an argument to the CalculateEstimands function. Unless you are an expert 
Amos programmer, you would not know how to use the AmosEngine object; however, 
there is an easy way to get the needed Visual Basic syntax by dragging and dropping.

Dragging and Dropping

E Find the direct effect in the Bayesian SEM window and click to select its row. (Its row 
is highlighted in the following figure.) 

E Move the mouse pointer to an edge of the selected row. Either the top edge or the 
bottom edge will do.

Tip: When you get the mouse pointer on the right spot, a plus (+) symbol will appear 
next to the mouse pointer. 
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E Hold down the left mouse button, drag the mouse pointer into the Visual Basic window 
to the spot where you want the expression for the direct effect to go, and release the 
mouse button.

When you complete this operation, Amos fills in the appropriate parameter expression, 
as shown in the next figure:

The parameter on the right side of the equation is identified by the label (“c”) that was 
used in the path diagram shown earlier. 

We next turn our attention to calculating the indirect effect of socioeconomic status 
on alienation in 1971. This indirect effect is defined as the product of its two direct 
effects, the direct effect of socioeconomic status on alienation in 1967 (parameter a) 
and the direct effect of alienation in 1967 on alienation in 1971 (parameter b). 
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E On the left side of the Visual Basic assignment statement for computing the indirect 
effect, type estimand(“indirect”) .value =. 

Using the same drag-and-drop process as previously described, start dragging things 
from the Bayesian SEM window to the Unnamed.vb window. 

E First, drag the direct effect of socioeconomic status on alienation in 1967 to the right 
side of the equals sign in the unfinished statement. 
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E Next, drag and drop the direct effect of 1967 alienation on 1971 alienation.

This second direct effect appears in the Unnamed.vb window as 
sem.ParameterValue(“b”).

E Finally, use the keyboard to insert an asterisk (*) between the two parameter values.

Hint: For complicated custom estimands, you can also drag and drop from the 
Additional Estimands window to the Custom Estimands window.
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To compute the difference between the direct and indirect effects, add a third line of 
Visual Basic syntax, as seen in the following figure:

E To find the posterior distribution of all three custom estimands, click File > Run (or 
click the Run button on the toolbar).

The results will take a few seconds. A status window keeps you informed of progress.
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The marginal posterior distributions of the three custom estimands are summarized in 
the following table:

The results for direct can also be found in the Bayesian SEM summary table, and the 
results for indirect can be found in the Additional Estimands table. We are really 
interested in difference. Its posterior mean is –0.132. Its minimum is –0.412, and its 
maximum is 0.111. 
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E To see its marginal posterior, from the menus, choose View Posterior.

E Select the difference row in the Custom Estimands table. 

Most of the area lies to the left of 0, meaning that the difference is almost sure to be 
negative. In other words, it is almost certain that the indirect effect is more negative 
than the direct effect. Eyeballing the posterior, perhaps 95% or so of the area lies to the 
left of 0, so there is about a 95% chance that the indirect effect is larger than the direct 
effect. It is not necessary to rely on eyeballing the posterior, however. There is a way 
to find any area under a marginal posterior or, more generally, to estimate the 
probability that any proposition about the parameters is true.
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Dichotomous Custom Estimands

Visual inspection of the frequency polygon reveals that the majority of difference 
values are negative, but it does not tell us exactly what proportion of values are 
negative. That proportion is our estimate of the probability that the indirect effect 
exceeds the direct effect. To estimate probabilities like these, we can use dichotomous 
estimands. In Visual Basic (or C#) programs, dichotomous estimands are just like 
numeric estimands except that dichotomous estimands take on only two values: true 
and false. In order to estimate the probability that the indirect effect is more negative 
than the direct effect, we need to define a function of the model parameters that is true 
when the indirect effect is more negative than the direct effect and is false otherwise.

Defining a Dichotomous Estimand

E Name each dichotomous estimand in the DeclareEstimands subroutine. For purposes of 
illustration, we will declare two dichotomous estimands, calling them “indirect is less 
than zero” and “indirect is smaller than direct”. 
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E Add lines to the CalculateEstimands function specifying how to compute them.

In this example, the first dichotomous custom estimand is true when the value of the 
indirect effect is less than 0. The second dichotomous custom estimand is true when 
the indirect effect is smaller than the direct effect.
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E Click File > Run (or click the Run button on the toolbar). 

Amos evaluates the truth of each logical expression for each MCMC sample drawn. 
When the analysis finishes, Amos reports the proportion of MCMC samples in which 
each expression was found to be true. These proportions appear in the Dichotomous 
Estimands section of the Custom Estimands summary table. 

The P column shows the proportion of times that each evaluated expression was true 
in the whole series of MCMC samples. In this example, the number of MCMC samples 
was 29,501, so P is based on approximately 30,000 samples. The P1, P2, and P3 
columns show the proportion of times each logical expression was true in the first third, 
the middle third, and the final third of the MCMC samples. In this illustration, each of 
these proportions is based upon approximately 10,000 MCMC samples. 
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Based on the proportions in the Dichotomous Estimands area of the Custom 
Estimands window, we can say with near certainty that the indirect effect is negative. 
This is consistent with the frequency polygon on p. 462 that showed no MCMC 
samples with an indirect effect value greater than or equal to 0. 

Similarly, the probability is about 0.975 that the indirect effect is larger (more 
negative) than the direct effect. The 0.975 is only an estimate of the probability. It is a 
proportion based on 29,501 correlated observations. However it appears to be a good 
estimate because the proportions from the first third (0.974), middle third (0.979) and 
final third (0.971) are so close together. 
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Data Imputation

Introduction

This example demonstrates multiple imputation in a factor analysis model.

About the Example

Example 17 showed how to fit a model using maximum likelihood when the data 
contain missing values. Amos can also impute values for those that are missing. In 
data imputation, each missing value is replaced by some numeric guess. Once each 
missing value has been replaced by an imputed value, the resulting completed dataset 
can be analyzed by data analysis methods that are designed for complete data. Amos 
provides three methods of data imputation.

 In regression imputation, the model is first fitted using maximum likelihood. 
After that, model parameters are set equal to their maximum likelihood estimates, 
and linear regression is used to predict the unobserved values for each case as a 
linear combination of the observed values for that same case. Predicted values are 
then plugged in for the missing values.

 Stochastic regression imputation (Little and Rubin, 2020) imputes values for 
each case by drawing, at random, from the conditional distribution of the missing 
values given the observed values, with the unknown model parameters set equal 
to their maximum likelihood estimates. Because of the random element in 
stochastic regression imputation, repeating the imputation process many times 
will produce a different completed dataset each time.
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 Bayesian imputation is like stochastic regression imputation except that it takes 
into account the fact that the parameter values are only estimated and not known.

Multiple Imputation

In multiple imputation (Schafer, 1997), a nondeterministic imputation method (either 
stochastic regression imputation or Bayesian imputation) is used to create multiple 
completed datasets. While the observed values never change, the imputed values vary 
from one completed dataset to the next. Once the completed datasets have been 
created, each completed dataset is analyzed alone. For example, if there are m 
completed datasets, then there will be m separate sets of results, each containing 
estimates of various quantities along with estimated standard errors. Because the m 
completed datasets are different from each other, the m sets of results will also differ 
from one to the next.

After each of the m completed datasets has been analyzed alone, the data analyst has 
m sets of estimates and standard errors that must be combined into a single set of results. 
Well-known formulas attributed to Rubin (1987) are available for combining the results 
from multiple completed datasets. Those formulas will be used in Example 31.

Model-Based Imputation

In this example, imputation is performed using a factor analysis model. Model-based 
imputation has two advantages. First, you can impute values for any latent variables in 
the model. Second, if the model is correct and has positive degrees of freedom, the 
implied covariance matrix and implied means will be estimated more accurately than 
with a saturated model. (Imputation is based on the implied covariance matrix and 
means.) However, a saturated model like the model in Example 1 can be used for 
imputation when no other model is appropriate.

Performing Multiple Data Imputation Using Amos Graphics

For this example, we will perform Bayesian multiple imputation using the 
confirmatory factor analysis model from Example 17. The dataset is the incomplete 
Holzinger and Swineford (1939) dataset in the file grant_x.sav. The imputation of 
missing values is only the first step in obtaining useful results from multiple 
imputation. Eventually, all three of the following steps need to be carried out.
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 Step 1: Use the Data Imputation feature of Amos to create m complete data files.

 Step 2: Perform an analysis of each of the m completed data files separately.

Performing this analysis is up to you. You can perform the analysis in Amos but, 
typically, you would use some other program. For purposes of this example and the 
next, we will use SPSS Statistics to carry out a regression analysis in which one 
variable (sentence) is used to predict another variable (wordmean). Specifically, we 
will focus on the estimation of the regression weight and its standard error.

 Step 3: Combine the results from the analyses of the m data files.

This example covers the first step. Steps 2 and 3 will be covered in Example 31.

E To generate the completed data files, open the Amos Graphics file Ex30.amw. 
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E From the menus, choose Analyze Data Imputation.

Amos displays the Amos Data Imputation window. 

E Make sure that Bayesian imputation is selected.

E Set Number of completed datasets to 10. (This sets m = 10.) 

You might suppose that a large number of completed data files are needed. It turns out 
that, in most applications, very few completed data files are needed. Five to 10 
completed data files are generally sufficient to obtain accurate parameter estimates and 
standard errors (Rubin, 1987). There is no penalty for using more than 10 imputations 
except for the clerical effort involved in Steps 2 and 3. 

Amos can save the completed datasets in a single file (Single output file) with the 
completed datasets stacked, or it can save each completed dataset in a separate file 
(Multiple output files). In a single-group analysis, selecting Single output file yields one 
output data file, whereas selecting Multiple output files yields m separate data files.

In a multiple-group analysis, when you select the Single output file option, you get a 
separate output file for each analysis group; if you select the Multiple output files option, 
you get m output files per group. For instance, if you had four groups and requested 
five completed datasets, then selecting Single output file would give you four output 
files, and selecting Multiple output files would give you 20. Since we are going to use 
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SPSS Statistics to analyze the completed datasets, the simplest thing would be to select 
Single output file. Then, the split file capability of SPSS Statistics could be used in Step 
2 to analyze each completed dataset separately. However, to make it easy to replicate 
this example using any regression program:

E Select Multiple output files.

You can save imputed data in two file formats: plain text or SPSS Statistics format.

E Click File Names to display a Save As dialog. 

E In the File name text box, you can specify a prefix name for the imputed datasets. Here, 
we have specified Grant_Imp. 

Amos will name the imputed data files Grant_Imp1, Grant_Imp2, and so on through 
Grant_Imp10.

E Use the Save as type drop-down list to select plain text (.txt) or the SPSS Statistics 
format (.sav). 
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E Click Save.

E Click Options in the Data Imputation window to display the available imputation 
options.

The online help explains these options. To get an explanation of an option, place your 
mouse pointer over the option in question and press the F1 key. The figure below shows 
how the number of observations can be changed from 10,000 (the default) to 30,000.

E Close the Options dialog and click the Impute button in the Data Imputation window. 
After a short time, the following message appears:

E Click OK.
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Amos lists the names of the completed data files.

Each completed data file contains 73 complete cases. Here is a view of the first few 
records of the first completed data file, Grant_Imp1.sav: 
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Here is an identical view of the second completed data file, Grant_Imp2.sav: 

The values in the first two cases for visperc were observed in the original data file and 
therefore do not change across the imputed data files. By contrast, the values for these 
cases for cubes were missing in the original data file, Grant_x.sav, so Amos has 
imputed different values across the imputed data files for cubes for these two cases.

In addition to the original observed variables, Amos added four new variables to the 
imputed data files. Spatial and verbal are imputed latent variable scores. CaseNo and 
Imputation_ are the case number and completed dataset number, respectively.
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Analyzing Multiply Imputed Datasets

Introduction

This example demonstrates the analysis of multiply (pronounced multiplee) imputed 
datasets.

Analyzing the Imputed Data Files Using SPSS Statistics

Ten completed datasets were created in Example 30. That was Step 1 in a three-step 
process: Use the Data Imputation feature of Amos to impute m complete data files. 
(Here, m = 10.) The next two steps are:

 Step 2: Perform an analysis of each of the m completed data files separately.

 Step 3: Combine the results from the analyses of the m data files.

The analysis in Step 2 can be performed using Amos, SPSS Statistics, or any other 
program. Without knowing ahead of time what program will be used to analyze the 
completed datasets, it is not possible to automate Steps 2 and 3.

To walk through Steps 2 and 3 for a specific problem, we will analyze the 
completed datasets by using SPSS Statistics to carry out a regression analysis in 
which one variable (sentence) is used to predict another variable (wordmean). We will 
focus specifically on the estimation of the regression weight and its standard error.
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Step 2: Ten Separate Analyses

For each of the 10 completed datasets from Example 30, we need to perform a 
regression analysis in which sentence is used to predict wordmean. We start by opening 
the first completed dataset, Grant_Imp1.sav, in SPSS Statistics.

E From the SPSS Statistics menus, choose Analyze Regression Linear and perform the 
regression analysis. (We assume you do not need detailed instructions for this step.) 

The results are as follows:

We are going to focus on the regression weight estimate (1.106) and its estimated 
standard error (0.160). Repeating the analysis that was just performed for each of the 
other nine completed datasets gives nine more estimates for the regression weight and 
for its standard error. All 10 estimates and standard errors are shown in the following 
table:

Coefficientsa

-2.712 3.110 -.872 .386

1.106 .160 .634 6.908 .000

(Constant)

sentence

Model

1

B Std. Error

Unstandardized Coefficients

Beta

Standardized
Coefficients

t Sig.

Dependent Variable: wordmeana. 
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Step 3: Combining Results of Multiply Imputed Data Files

The standard errors from an analysis of any single completed dataset are not accurate 
because they do not take into account the uncertainty arising from imputing missing 
data values. The estimates and standard errors must be gathered from the separate 
analyses of the completed data files and combined into single summary values, one 
summary value for the parameter estimate and another summary value for the standard 
error of the parameter estimate. Formulas for doing this (Rubin, 1987) can be found in 
many places. The formulas below were taken from Schafer (1997, p. 109). The 
remainder of this section applies those formulas to the table of 10 estimates and 10 
standard errors shown above. In what follows:

Let m be the number of completed datasets (m = 10 in this case).

Let  be the estimate from sample t, so  = 1.106,  = 1.080, and so on. 

Let  be the estimated standard error from sample t, so  = 0.160,  = 
0.160, and so on.

Then the multiple-imputation estimate of the regression weight is simply the mean of 
the 10 estimates from the 10 completed datasets:

Imputation ML Estimate ML Standard Error

1 1.106 0.160
2 1.080 0.160
3 1.118 0.151
4 1.273 0.155
5 1.102 0.154
6 1.286 0.152
7 1.121 0.139
8 1.283 0.140
9 1.270 0.156
10 1.081 0.157

Q̂ t  Q̂ 1  Q̂ 2 

U t  U 1  U 2 

  172.1ˆ1

1

 


m

t

tQ
m

Q
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To obtain a standard error for the combined parameter estimate, go through the 
following steps:

E Compute the average within-imputation variance.

E Compute the between-imputation variance.

E Compute the total variance.

The multiple-group standard error is then

A test of the null hypothesis that the regression weight is 0 in the population can be 
based on the statistic

which, if the regression weight is 0, has a t distribution with degrees of freedom given 
by

Joseph Schafer’s NORM program performs these calculations. NORM can be 
downloaded from http://www.stat.psu.edu/~jls/misoftwa.html#win.

U 1
m
---- U t 

t 1=

m

 0.0233= =

B 1
m 1–
------------- Q̂ t  Q– 

t 1=

m

=
2

0.0085=

T U= 1 1
m
----+ 

 B+ 0.0233= 1 1
10
------+ 

  0.0085+ 0.0326=

T 0.0326 0.1807= =

Q
T

------- 1.172
0.1807
---------------- 6.49= =

v m 1– = 1 U

1 1
m
----+ 

 B
-----------------------+

2

10 1– = 1 0.0233

1 1
10
------+ 

  0.0085
-------------------------------------+

2

109=

http://www.stat.psu.edu/~jls/misoftwa.html#win
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Further Reading

Amos provides several advanced methods of handling missing data, including FIML 
(described in Example 17), multiple imputation, and Bayesian estimation. To learn 
more about each method, consult Schafer and Graham (2002) for an overview of the 
strengths of FIML and multiple imputation. Allison has a concise, readable monograph 
that covers both FIML and multiple imputation, including a number of worked 
examples and an excellent discussion of how to handle non-normal and categorical 
variables within the context of multiple imputation methods that assume multivariate 
normality (Allison, 2002). Schafer (1997) provides an in-depth, technical treatment of 
multiple imputation. Schafer and Olsen (1998) provide a readable, step-by-step guide 
to performing multiple imputation. 

A SEM-specific study comparing the statistical performance of FIML and multiple 
imputation in structural equation models is also available (Olinsky, Chen, and Harlow, 
2003). Lastly, it is worth noting that the Bayesian estimation approach discussed in 
Examples 26 through 29 is similar to FIML in its handling of missing data. Ibrahim 
and colleagues recently compared the performance of FIML, Bayesian estimation, 
probability weighting, and multiple imputation approaches to address incomplete data 
problems and concluded that these four approaches were generally similar in their 
satisfactory performance for handling incomplete data problems in which the missing 
data arose from a missing-at-random (MAR) process (Ibrahim, Chen, Lipsitz, and 
Herring, 2005). While their review considered generalized linear models rather than 
SEM, their results and conclusions should be generally applicable to a wide range of 
statistical models and data analysis scenarios, including those featuring SEM.
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Introduction

This example demonstrates parameter estimation, estimation of posterior predictive 
distributions, and data imputation with censored data.

About the Data

For this example, we use the censored data from 103 patients who were accepted into 
the Stanford Heart Transplantation Program during the years 1967 through 1974. The 
data were collected by Crowley and Hu (1977) and have been reanalyzed by 
Kalbfleisch and Prentice (2002), among others. The dataset is saved in the file 
transplant-a.sav.
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Reading across the first visible row in the figure above, Patient 17 was accepted into 
the program in 1968. The patient at that time was 20.33 years old. The patient died 35 
days later. The next number, 5.916, is the square root of 35. Amos assumes that 
censored variables are normally distributed. The square root of survival time will be 
used in this example in the belief that it is probably more nearly normally distributed 
than is survival time itself. Uncensored simply means that we know how long the 
patient lived. In other words, the patient has already died, and that is how we are able 
to tell that he lived for 35 days after being admitted into the program.

Some patients were still alive when last seen. For example, Patient 25 entered the 
program in 1969 at the age of 33.22 years. The patient was last seen 1,799 days later. 
The number 42.415 is the square root of 1,799. The word censored in the Status column 
means that the patient was still alive 1,799 days after being accepted into the program, 
and that is the last time the patient was seen. So, we can’t say that the patient survived 
for 1,799 days. In fact, he survived for longer than that; we just don’t know how much 
longer. There are more cases like that. Patient number 26 was last seen 1,400 days after 
acceptance into the program and, at that time, was still alive, so we know that that 
patient lived for at least 1,400 days.

It is not clear what is to be done with a censored value like Patient 25’s survival time 
of 1,799 days. You can’t just discard the 1,799 and all the other censored values 
because that amounts to discarding the patients who lived a long time. On the other 
hand, you can’t keep the 1,799 and treat it as an ordinary score because you know the 
patient really lived for more than 1,799 days.
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In Amos, you can use the information that Patient 25 lived for more than 1,799 days, 
neither discarding the information nor pretending that the patient’s survival time is 
known more precisely than it is. Of course, wherever the data provide an exact numeric 
value, as in the case of Patient 24 who is known to have survived for 218 days, that 
exact numeric value is used.

Recoding the Data

The data file needs to be recoded before Amos reads it. The next figure shows a portion 
of the dataset after recoding. (This complete dataset is in the file transplant-b.sav.)

Every uncensored observation appears in the new data file just the way it did in the 
original data file. Censored values, however, are coded differently. For example, 
Patient 25’s survival time, which is known only to be greater than 1,799, is coded as 
> 1799 in the new data file. (Spaces in a string like > 1799 are optional.) The square root 
of survival time is known to be greater than 42.415, so the timesqr column of the data 
file contains > 42.415 for Patient 25. For data file formats (like SPSS Statistics) that 
make a distinction between numeric and string variables, time and timesqr need to be 
coded as string variables.
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Analyzing the Data

To specify the data file in Amos Graphics:

E From the menus, choose File Data Files.

E Then in the Data Files dialog, click the File Name button.

E Select the data file transplant-b.sav. 

E Select Allow non-numeric data (a check mark appears next to it).

Recoding the data as shown above and selecting Allow non-numeric data are the only 
extra steps that are required for analyzing censored data. In all other respects, fitting a 
model with censored data and interpreting the results is exactly the same as if the data 
were purely numeric.
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Performing a Regression Analysis

Let’s try predicting timesqr using age and year of acceptance (acceptyr) as predictors. 
Begin by drawing the following path diagram:

To fit the model:

E Click  on the toolbar.

or

E From the menus, choose Analyze Bayesian Estimation.

Note: The  button is disabled because, with non-numeric data, you can perform only 
Bayesian estimation.

After the Bayesian SEM window opens, wait until the unhappy face  changes into 
a happy face . The table of estimates in the Bayesian SEM window should look 
something like this:

timesqr

age
0,

e
1

acceptyr
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(Only a portion of the table is shown in the figure.) The Mean column contains point 
estimates for the parameters. The regression weight for using acceptyr to predict 
timesqr is 1.45, so that each time the calendar advances by one year, you predict an 
increase of 1.45 in the square root of survival time. This suggests that the transplant 
program may have been improving over the period covered by the study. The 
regression weight for using age to predict timesqr is –0.29, so for every year older a 
patient is when admitted into the transplant program, you expect a decrease of 0.29 in 
the square root of survival time. The regression weight estimate of –0.29 is actually the 
mean of the posterior distribution of the regression weight. 
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E To see the entire posterior distribution, right-click the row that contains the –0.29 
estimate and choose Show Posterior from the pop-up menu.

The Posterior dialog opens, displaying the posterior distribution of the regression 
weight.

The posterior distribution of the regression weight is indeed centered around –0.29. 
The distribution lies almost entirely between –0.75 and 0.25, so it is practically 
guaranteed that the regression weight lies in that range. Most of the distribution lies 
between –0.5 and 0, so we are pretty sure that the regression weight lies between –0.5 
and 0.
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Posterior Predictive Distributions

Recall that the dataset contains some censored values like Patient 25’s survival time. 
All we really know about Patient 25’s survival time is that it is longer than 1,799 days 
or, equivalently, that the square root of survival time exceeds 42.415. Even though we 
do not know the amount by which this patient’s timesqr exceeds 42.415, we can ask for 
its posterior distribution. Taking into account the fact that timesqr exceeds 42.415, 
assuming that the model is correct, and taking the patient’s age and acceptyr into 
account, what can be said about Patient 25’s survival time? To find out:

E Click the Posterior Predictive button .

or

E From the menus, choose View Posterior Predictive.

The Posterior Predictive Distributions window shows a table with a row for every 
person and a column for every observed variable in the model. Looking in the 25th row, 
we see Patient 25’s age and acceptyr scores. For Patient 25’s timesqr, all we see is the 
symbol <<, which indicates that the data provide an inequality constraint on the timesqr 
score and not an actual numeric value.
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To see the posterior distribution of Patient 25’s timesqr:

E Click <<. The posterior distribution appears in the Posterior window.

The posterior distribution for Patient 25’s timesqr lies entirely to the right of 42.415. 
Of course, we knew from the data alone that timesqr exceeds 42.415, but now we also 
know that there is practically no chance that Patient 25’s timesqr exceeds 70. For that 
matter, there is only a slim chance that timesqr exceeds even 55.
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To see a posterior predictive distribution that looks very different from Patient 25’s:

E Click the << symbol in the 100th row of the Posterior Predictive Distributions table.

Patient 100 was still alive when last observed on the 38th day after acceptance into the 
program, so that his timesqr is known to exceed 6.164. The posterior distribution of 
that patient’s timesqr shows that it is practically guaranteed to be between 6.164 and 
70, and almost certain to be between, 6.164 and 50. The mean is 27.36, providing a 
point estimate of timesqr if one is needed. Squaring 27.36 gives 748, an estimate of 
Patient 100’s survival time in days.
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Imputation

You can use this model to impute values for the censored values.

E Close the Bayesian SEM window if it is open.

E From the Amos Graphics menu, choose Analyze Data Imputation.

Notice that Regression imputation and Stochastic regression imputation are disabled. 
When you have non-numeric data such as censored data, Bayesian imputation is the only 
choice.

We will accept the options shown in the preceding figure, creating 10 completed 
datasets and saving all 10 in a single SPSS Statistics data file called transplant-
b_C.sav. To start the imputation:



502

Example 32

E Click the Impute button.

The Bayesian SEM window opens along with the Data Imputation dialog.

E Wait until the Data Imputation dialog displays a happy face  to indicate that each 
of the 10 completed datasets is effectively uncorrelated with the others.

Note: After you see a happy face but before you click OK, you may optionally choose to 
right-click a parameter in the Bayesian SEM window and choose Show Posterior from 
the pop-up menu. This will allow you to examine the Trace and Autocorrelation plots.

E Click OK in the Data Imputation dialog.
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The Summary window shows a list of the completed data files that were created. In this 
case, only one completed data file was created.

E Double-click the file name to display the contents of the single completed data file, 
which contains 10 completed datasets. 
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The file contains 1,030 cases because each of the 10 completed datasets contains 103 
cases. The first 103 rows of the new data file contain the first completed dataset. The 
Imputation_ variable is equal to 1 for each row in the first completed dataset, and the 
CaseNo variable runs from 1 through 103.
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The first row of the completed data file contains a timesqr value of 7. Because that was 
not a censored value, 7 is not an imputed value. It is just an ordinary numeric value that 
was present in the original data file. On the other hand, Patient 25’s timesqr was 
censored, so that patient has an imputed timesqr (in this case, 49.66.) The value of 
49.66 is a value drawn randomly from the posterior predictive distribution in the figure 
on p. 499.

Normally, the next step would be to use the 10 completed datasets in transplant-
b_C.sav as input to some other program that cannot accept censored data. You would 
use that other program to perform 10 separate analyses, using each one of the 10 
completed datasets in turn. Then you would do further computations to combine the 
results of those 10 separate analyses into a single set of results, as was done in Example 
31. Those steps will not be carried out here.

General Inequality Constraints on Data Values

This example employed only inequality constraints like > 1799. Here are some other 
examples of string values that can be used in a data file to place inequality constraints 
on the value of an underlying numeric variable:

 The string value < 5 means that the underlying numeric value is less than 5.

 The string value 4<<5 means that the underlying numeric value is between 4 and 5.
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33
Ordered-Categorical Data

Introduction

This example shows how to fit a factor analysis model to ordered-categorical data. It 
also shows how to find the posterior predictive distribution for the numeric variable 
that underlies a categorical response and how to impute a numeric value for a 
categorical response.

About the Data

This example uses data on attitudes toward environment issues obtained from a 
questionnaire administered to 1,017 respondents in the Netherlands. The data come 
from the European Values Study Group (see the bibliography for a citation). The data 
file environment-nl-string.sav contains responses to six questionnaire items with 
categorical responses strongly disagree (SD), disagree (D), agree (A), and strongly 
agree (SA).
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One way to analyze these data is to assign numbers to the four categorical responses; 
for example, using the assignment 1 = SD, 2 = D, 3 = A, 4 = SA. If you assign numbers 
to categories in that way, you get the dataset in environment-nl-numeric.sav.

In an Amos analysis, it is not necessary to assign numbers to categories in the way just 
shown. It is possible to use only the ordinal properties of the four categorical responses. 
If you want to use only the ordinal properties of the data, you can use either dataset, 
environment-nl-string.sav or environment-nl-numeric.sav.
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It may be slightly easier to use environment-nl-numeric.sav because Amos will 
assume by default that the numbered categories go in the order 1, 2, 3, 4, with 1 being 
the lowest category. That happens to be the correct order. With environment-nl-
string.sav, by contrast, Amos will assume by default that the categories are arranged 
alphabetically in the order A, D, SA, SD, with A being the lowest category. That is the 
wrong order, so the default ordering of the categories by Amos has to be overridden.

The data file environment-nl-string.sav will be used for this example because then 
it will be clear that only the ordinal properties of the data are employed, and also you 
can see how to specify the correct ordering of the categories.

Specifying the Data File

E From the Amos Graphics menus, choose File Data Files. 

E In the Data Files window, click the File Name button.

E Select the data file environment-nl-string.sav. 

E Select Allow non-numeric data (a check mark appears next to it).

E Click OK.
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Recoding the Data within Amos

The ordinal properties of the data cannot be inferred from the data file alone. To give 
Amos the additional information it needs so that it can interpret the data values SD, D, 
A, and SA:

E From the Amos Graphics menus, choose Tools Data Recode. 

E Select item1 in the list of variables in the upper-left corner of the Data Recode window.

This displays a frequency distribution of the responses to item1 at the bottom of the 
window.
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In the box labeled Recoding rule, the notation No recoding means that Amos will read 
the responses to item1 as is. In other words, it will read either SD, D, A, SA, or an empty 
string. We can’t leave things that way because Amos doesn’t know what to do with SD, 
D, and so on.

E Click No recoding and select Ordered-categorical from the drop-down list.
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The frequency table at the bottom of the window now has a New Value column that 
shows how the item1 values in the data file will be recoded before Amos reads the data. 
The first row of the frequency table shows that empty strings in the original data file 
will be treated as missing values. The second row shows that the A response will be 
translated into the string <0.0783345405060296. Amos will interpret this to mean that 
there is a continuous numeric variable that underlies responses to item1, and that a 
person who gives the A response has a score that is less than 0.0783345405060296 on 
that underlying variable. Similarly, the third row shows that the D response will be 
translated into the string 0.0783345405060296<<0.442569286522029 and interpreted 
by Amos to mean that the score on the underlying numeric variable is between 
0.0783345405060296 and 0.442569286522029. The numbers, 0.0783345405060296, 
0.442569286522029, and so on, are derived from the frequencies in the Frequency 
column, based on the assumption that scores on the underlying numeric variable are 
normally distributed with a mean of 0 and a standard deviation of 1.
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The ordering of the categories in the Original Value column needs to be changed. To 
change the ordering:

E Click the Details button. The Ordered-Categorical Details dialog opens.

The Ordered categories list box shows four response categories arranged in the order 
A, D, SA, SD, and separated from each other by dashed lines, <---->. The dashed 
lines represent three boundaries that divide the real numbers into four intervals, with 
the four intervals being associated with the four categorical responses. The assumption 
is made that a person who scores below the lowest boundary on some unobserved 
numeric variable gives the A response. A person who scores between the lowest 
boundary and the middle boundary gives the D response. A person who scores between 
the middle boundary and the highest boundary gives the SA response. Finally, a person 
who scores above the highest boundary gives the SD response.

The program is correct about there being four categories (intervals) and three 
boundaries, but it has the ordering of the categories wrong. The program arbitrarily 
alphabetized the categories. We need to keep the four categories and the three 
boundaries but rearrange them. We want SD to fall in the lowest interval (below the 
lowest boundary), and so on. 
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You can rearrange the categories and the boundaries. To do this:

E Drag and drop with the mouse.

or

E Select a category or boundary with the mouse and then click the Up or Down button.

After putting the categories and boundaries in the correct order, the Ordered-
Categorical Details dialog looks like this:

The Unordered categories list box contains a list of values that Amos will treat as 
missing. At the moment, the list contains one entry, [empty string], so that Amos will 
treat an empty string as a missing value. If a response coded as an empty string was 
actually a response that could be meaningfully compared to SD, D, A, and SA, then you 
would select [empty string] in the Unordered categories list box and click the Down 
button to move [empty string] into the Ordered categories list box. 

Similarly, if a response in the Ordered categories list box, for example SD, was not 
comparable to the other responses, you would select it with the mouse and click the Up 
button to move it into the Unordered categories list box. Then SD would be treated as 
a missing value.
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Note: You can’t drag and drop between the Ordered categories list box and the 
Unordered categories list box. You have to use the Up and Down buttons to move a 
category from one box to the other.

We could stop here and close the Ordered-Categorical Details dialog because we have 
the right number of boundaries and categories and we have the categories going in the 
right order. However, we will make a further change based on a suggestion by Croon 
(2002), who also worked with this dataset and concluded that the SD category occurred 
so seldom that it should be combined with the D category. To merge those two 
categories into a single category:

E Select the boundary between the two categories you want to merge.

E Click the Remove Boundary button. The Ordered categories list now looks like this:

Now the SD response and the D response are indistinguishable. Either response means 
that the person who gave the response has a score that lies in the lowest interval on the 
underlying numeric variable.
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There remains the question of the values of the two boundaries that separate the 
three intervals. If you do not specify values for the boundaries, Amos will estimate the 
boundaries by assuming that scores on the underlying numeric variable are normally 
distributed with a mean of 0 and a standard deviation of 1. Alternatively, you can 
assign a value to a boundary instead of letting Amos estimate it. To assign a value:

E Select the boundary with the mouse.

E Type a numeric value in the text box.

The following figure shows the result of assigning values 0 and 1 to the two boundaries.

Although it may not be obvious, it is permissible to assign 0 and 1, or any pair of 
numbers, to the two boundaries, as long as the higher boundary is assigned a larger 
value than the lower one. No matter how many boundaries there are (as long as there 
are at least two), assigning values to two of the boundaries amounts to choosing a zero 
point and a unit of measurement for the underlying numeric variable. The scaling of 
the underlying numeric variable is discussed further in the Help file under the topic 
“Choosing boundaries when there are three categories.”

E Click OK to close the Ordered-Categorical Details dialog.
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The changes that were just made to the categories and the interval boundaries are now 
reflected in the frequency table at the bottom of the Data Recode window.

The frequency table shows how the values that appear in the data file will be recoded 
before Amos reads them. Reading the frequency table from top to bottom:

 An empty string will be treated as a missing value.

 The strings SD and D will be recoded as <0, meaning that the underlying numeric 
score is less than 0.

 A will be recoded as 0<<1, meaning that the underlying numeric score is between 
0 and 1.

 SA will be recoded as >1, meaning that the underlying numeric score is greater
than 1.
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That takes care of item1. What was just done for item1 has to be repeated for each of 
the five remaining observed variables. After specifying the recoding for all six 
observed variables, you can view the original dataset along with the recoded variables. 
To do this:

E Click the View Data button.

The table on the left shows the contents of the original data file before recoding. The 
table on the right shows the recoded variables after recoding. When Amos performs an 
analysis, it reads the recoded values, not the original values.

Note: You can create a raw data file in which the data recoding has already been 
performed. In other words, you can create a raw data file that contains the inequalities 
on the right-hand side of the figure above. In that case, you wouldn’t need to use the 
Data Recode window in Amos. Indeed, that approach was used in Chapter 32.

E Finally, close the Data Recode window before specifying the model.
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Specifying the Model

After you have specified the rules for data recoding as shown above, the analysis 
proceeds just like any Bayesian analysis. For this example, a factor analysis model will 
be fitted to the six questionnaire items in the environment dataset. The first three items 
were designed to be measures of willingness to spend money to take care of the 
environment. The other three items were designed to be measures of awareness of 
environmental issues. This design of the questionnaire is reflected in the following 
factor analysis model, which is saved in the file Ex33-a.amw.

The path diagram is drawn exactly as it would be drawn for numeric data. This is one 
of the good things about having at least three categories for each ordered-categorical 
variable: You can specify a model in the way that you are used to, just as though all the 
variables were numeric, and the model will work for any combination of numeric and 
ordered-categorical variables. If variables are dichotomous, you will need to impose 
additional parameter constraints in order to make the model identified. This issue is 
discussed further in the online help under the topic “Parameter identification with 
dichotomous variables.”
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Fitting the Model

E Click  on the toolbar.

or

E From the menus, choose Analyze Bayesian Estimation.

Note: The  button is disabled because, with non-numeric data, you can perform only 
Bayesian estimation.

After the Bayesian SEM window opens, wait until the unhappy face changes into a 
happy face. The Bayesian SEM window should then look something like this:

(The figure above shows some, but not all, of the parameter estimates.) The Mean 
column provides a point estimate for each parameter. For example, the regression 
weight for using WILLING to predict item1 is estimated to be 0.59. The skewness 
(0.09) and kurtosis (–0.01) of the posterior distribution are close to 0, which is 
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compatible with the posterior distribution being nearly normal. The standard deviation 
(S.D.) is 0.03, so there is about a 67% chance that the regression weight is within 0.03 
of 0.59. Doubling the standard deviation gives 0.06, so there is about a 95% chance that 
the regression weight is within 0.06 of 0.59. 

To view the posterior distribution of the regression weight:

E Right-click its row and choose Show Posterior from the pop-up menu.
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The Posterior window displays the posterior distribution. The appearance of the 
distribution confirms what was concluded above from the mean, standard deviation, 
skewness, and kurtosis of the distribution. The shape of the distribution is nearly 
normal, and it looks like roughly 95% of the area lies between 0.53 and 0.65 (that is, 
within 0.06 of 0.59). 
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MCMC Diagnostics

If you know how to interpret the diagnostic output from MCMC algorithms (for 
example, see Gelman et al, 2013), you might want to view the Trace plot and the 
Autocorrelation plot.
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The First and last plot provides another diagnostic. It shows two estimates of the 
posterior distribution (two superimposed plots), one estimate from the first third of the 
MCMC sample and another estimate from the last third of the MCMC sample.
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Posterior Predictive Distributions

When you think of estimation, you normally think of estimating model parameters or 
some function of the model parameters such as a standardized regression weight or an 
indirect effect. However, there are other unknown quantities in the present analysis. 
Each entry in the data table on p. 508 represents a numeric value that is either unknown 
or partially known. For example, Person 1 did not respond to item2, so we can only 
guess at (estimate) that person’s score on the underlying numeric variable. On the other 
hand, it seems like we ought to be able to make a fairly educated guess about the 
underlying numeric value, considering that we know how the person responded to the 
other items, and that we can also make use of the assumption that the model is correct.

We are in an even better position to guess at Person 1’s score on the numeric 
variable that underlies item1 because Person 1 gave a response to item1. This person’s 
response places his or her score in the middle interval, between the two boundaries. 
Since the two boundaries were arbitrarily fixed at 0 and 1, we know that the score is 
somewhere between 0 and 1, but it seems like we should be able to say more than that 
by using the person’s responses on the other variables along with the assumption that 
the model is correct.

In Bayesian estimation, all unknown quantities are treated in the same way. Just as 
unknown parameter values are estimated by giving their posterior distribution, so are 
unknown data values. A posterior distribution for an unknown data value is called a 
posterior predictive distribution, but it is interpreted just like any posterior 
distribution. To view posterior predictive distributions for unknown data values:

E Click the Posterior Predictive button .

or

E From the menus, choose View Posterior Predictive.

The Posterior Predictive Distributions window appears.
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The Posterior Predictive Distributions window contains a table with a row for every 
person and a column for every observed variable in the model. An asterisk (*) indicates 
a missing value, while << indicates a response that places inequality constraints on the 
underlying numeric variable. To display the posterior distribution for an item:
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E Click on the table entry in the upper-left corner (Person 1’s response to item1).

The Posterior window opens, displaying the posterior distribution of Person 1’s 
underlying numeric score. At first, the posterior distribution looks jagged and random.

That is because the program is building up an estimate of the posterior distribution as 
MCMC sampling proceeds. The longer you wait, the better the estimate of the posterior 
distribution will be. After a while, the estimate of the posterior distribution stabilizes 
and looks something like this:
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The posterior distribution shows that Person 1’s score on the numeric variable that 
underlies his or her response to item1 is between 0 and 1 (which we knew already), and 
that the score is more likely to be close to 1 than close to 0.

E Next, click the table entry in the first column of the 22nd row to estimate Person 22’s 
score on the numeric variable that underlies his or her response to item1. 

After you wait a while to get a good estimate of the posterior distribution, you see this:

Both Person 1 and Person 22 gave the agree response to item1, so both people have 
scores between 0 and 1 on the underlying numeric variable; however, their posterior 
distributions are very different
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For another example of a posterior predictive distribution, select a missing value 
like Person 1’s response to item2. After allowing MCMC sampling to proceed long 
enough to get a good estimate of the posterior distribution, it looks like this:

The mean of the posterior distribution (0.52) can be taken as an estimate of Person 1’s 
score on the underlying variable if a point estimate is required. Looking at the plot of 
the posterior distribution, we can be nearly 100% sure that the score is between –1 and 
2. The score is probably between 0 and 1 because most of the area under the posterior 
distribution lies between 0 and 1.

Posterior Predictive Distributions for Latent Variables

Suppose you want to estimate Person 1’s score on the WILLING factor. Amos can 
estimate posterior predictive distributions for unknown scores only for observed 
variables. It cannot estimate a posterior predictive distribution of a score on a latent 
variable. However, there is a trick that you can use to estimate the posterior predictive 
distribution of a score on WILLING. You can change WILLING to an observed 
variable, treating it not as a latent variable but as an observed variable that has a missing 
value for every case. That requires two changes – a change to the path diagram and a 
change to the data. 

In the path diagram, the WILLING ellipse has to be changed into a rectangle. To 
accomplish this:
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E Right-click the WILLING ellipse and choose Toggle Observed/Unobserved from the pop-
up menu.

E Click the WILLING ellipse.

The WILLING ellipse changes to a rectangle so that the path diagram looks like this:

That takes care of the path diagram. It is also necessary to make a change to the data 
because if WILLING is an observed variable, then there has to be a WILLING column 
in the data file. You can directly modify the data file. Since this is a data file in SPSS 
Statistics format, you would use SPSS Statistics to add a WILLING variable to the data 
file, making sure that all the scores on WILLING are missing. 

To avoid changing the original data file:

E Right-click the WILLING variable in the path diagram

E Choose Data Recode from the pop-up menu to open the Data Recode window.
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E In the Data Recode window, click Create Variable. A new variable with the default 
name V1, appears in the New and recoded variables list box.
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E Change V1 to WILLING. (If necessary, click the Rename Variable button.)

E You can optionally view the recoded dataset that includes the new WILLING variable 
by clicking the View Data button.
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The table on the left shows the original dataset. The table on the right shows the 
recoded dataset as read by Amos. It includes item1 through item6 after recoding, and 
also the new WILLING variable.

E Close the Data Recode window.

E Start the Bayesian analysis by clicking  on the Amos Graphics toolbar. 

E In the Bayesian SEM window, wait until the unhappy face  changes into a happy 
face  and then click the Posterior Predictive button .
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E Click the entry in the upper-right corner of the table to display the posterior distribution 
of Person 1’s score on the WILLING factor.

Imputation

Data imputation works the same way for ordered-categorical data as it does for 
numeric data. With ordered-categorical data, you can impute numeric values for 
missing values, for scores on latent variables, and for scores on the unobserved numeric 
variables that underlie observed ordered-categorical measurements.

You need a model in order to perform imputation. You could use the factor analysis 
model that was used earlier. There are several advantages and one disadvantage to 
using the factor analysis model for imputation. One advantage is that, if the model is 
correct, you can impute values for the factors. That is, you can create a new data set in 
which WILLING and AWARE are observed variables. The other advantage is that, if 
the factor analysis model is correct, it can be expected to give more accurate 
imputations for item1 through item6 than would be obtained from a less restrictive 
model. The disadvantage of using the factor analysis model is that it may be wrong. To 
be on the safe side, the present example will use the model that has the biggest chance 
of being correct, the saturated model shown in the following figure. (See the file
Ex33-c.amw.)
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After drawing the path diagram for the saturated model, you can begin the imputation.

E From the Amos Graphics menu, choose Analyze Data Imputation.
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In the Amos Data Imputation window, notice that Regression imputation and Stochastic 
regression imputation are disabled. When you have non-numeric data, Bayesian 
imputation is the only choice.

We will accept the options shown in the preceding figure, creating 10 completed 
datasets and saving all 10 in a single SPSS Statistics data file called environment-nl-
string_C.sav. To start the imputation:

E Click the Impute button. 

The Bayesian SEM window opens along with the Data Imputation dialog box.

E Wait until the Data Imputation dialog box displays a happy face  to indicate that 
each of the 10 completed data sets is effectively uncorrelated with the others.

Note: After you see a happy face but before you click OK, you may optionally right-
click a parameter in the Bayesian SEM window and choose Show Posterior from the 
pop-up menu. This will allow you to examine the Trace and Autocorrelation plots.
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E Click OK in the Data Imputation dialog box.

The Summary window shows a list of the completed data files that were created. In this 
case, only one completed data file was created.

E Double-click the file name in the Summary window to display the contents of the 
single completed data file, which contains 10 completed data sets.

The file contains 10,170 cases because each of the 10 completed datasets contains 
1,017 cases. The first 1,017 rows of the new data file contain the first completed 
dataset. The Imputation_ variable is equal to 1 for each row in the first completed 
dataset, and the CaseNo variable runs from 1 through 1,017 before starting over 
again at 1.
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Normally, the next step would be to use the 10 completed datasets in environment-nl-
string_C.sav as input to some other program that requires numeric (not ordered-
categorical) data. You would use that other program to perform 10 separate analyses 
using each one of the 10 completed data sets in turn. Then, you would do further 
computations to combine the results of those 10 separate analyses into a single set of 
results, as was done in Example 31. Those steps will not be carried out here.
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34
Mixture Modeling with Training Data

Introduction

Mixture modeling is appropriate when you have a model that is incorrect for an entire 
population, but where the population can be divided into subgroups in such a way that 
the model is correct in each subgroup.

Mixture modeling is discussed in the context of structural equation modeling by 
Arminger, Stein, and Wittenberg (1999), Hoshino (2001), Lee (2007, Chapter 11), 
Loken (2004), Vermunt and Magidson (2005), and Zhu and Lee (2001), among 
others.

The present example demonstrates mixture modeling for the situation in which 
some cases have already been assigned to groups while other cases have not. It is up 
to Amos to learn from the cases that are already classified and to classify the others.

We begin mixture modeling with an example in which some cases have already 
been classified because setting up such an analysis is almost identical to setting up an 
ordinary multiple-group analysis such as in Examples 10, 11, and 12.

It is possible to perform mixture modeling when no cases have been classified in 
advance so that the program must classify every case. Example 35 demonstrates this 
type of analysis.
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About the Data

The data for this example were collected by Anderson (1935) and used by Fisher 
(1936) to demonstrate discriminant analysis. The original data are in the file iris.sav, 
of which a portion is shown here:

The dataset contains four measurements on flowers from 150 different plants. The first 
50 flowers were irises of the species setosa. The next 50 were irises of the species 
versicolor. The last 50 were of the species virginica.



543

Mixture Modeling with Training Data

A scatterplot of two of the numeric measurements, PetalLength and PetalWidth, 
suggests that those two measurements alone will be useful in classifying the flowers 
according to species.

The setosa flowers are all by themselves in the lower left corner of the scatterplot. It 
should therefore be easy for Amos to use PetalLength and PetalWidth to distinguish 
the setosa flowers from the others. On the other hand, there is some overlap of 
versicolor and virginica, so we should expect that sometimes it will be hard to tell 
whether a flower is versicolor or virginica purely on the basis of PetalLength and 
PetalWidth.

 setosa
 versicolor
 virginica

Species

0.5 1.0 1.5 2.0 2.5

PetalWidth

2.0

4.0

6.0

P
et

al
L

e
n

g
th







 




 

















 



 


























































 













 













 





























































































544

Example 34

This example will not use the iris.sav dataset, which gives the species of every 
flower. Instead, the example will use the iris3.sav dataset, which gives the species for 
only a few flowers. The following figure shows a portion of the iris3.sav dataset.

Species information is available for 10 of the setosa flowers, 10 of the versicolor 
flowers, and 10 of the virginica flowers. Species is unknown for the remaining 120 
flowers. When Amos analyzes these data, it will have 10 examples of each kind of 
flower to assist in classifying the rest of the flowers.
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Performing the Analysis

E From the menus, choose File New to start a new path diagram.

E From the menus, choose Analyze Manage Groups.

E In the Manage Groups dialog, change the name in the Group Name text box from 
Group number 1 to PossiblySetosa.

E Click New to create a second group.

E Change the name in the Group Name text box from Group number 2 to 
PossiblyVersicolor.
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E Click New to create a third group.

E Change the name in the Group Name text box from Group number 3 to 
PossiblyVirginica.

E Click Close.

Specifying the Data File

E From the menus, choose File Data Files.

E Click PossiblySetosa to select that row.
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E Click File Name, select the iris3.sav file that is in the Amos Examples directory, and 
click Open.

E Click Grouping Variable and double-click Species in the Choose a Grouping Variable 
dialog. This tells the program that the Species variable will be used for classifying 
flowers.
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E In the Data Files dialog, click Group Value and then double-click setosa in the Choose 
Value for Group dialog.
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The Data Files dialog should now look like this:

E Repeat the preceding steps for the PossiblyVersicolor group, but this time double-click 
versicolor in the Choose Value for Group dialog.

E Repeat the preceding steps once more for the PossiblyVirginica group, but this time 
double-click virginica in the Choose Value for Group dialog. The Data Files dialog will 
end up looking like this:
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So far, the analysis has been set up exactly like an ordinary three-group analysis in 
which the species of every flower is known. The next step is unique to mixture 
modeling. 

E Select Assign cases to groups (a check mark will appear next to it). The check mark tells 
Amos to assign a case to a group whenever the dataset does not specify which group 
that case belongs to.

E Click OK to close the Data Files dialog.

Specifying the Model

We will use a saturated model for the variables PetalLength and PetalWidth. The 
scatterplot that was shown earlier suggests that these two variables will allow the 
program to do a good job of classifying the flowers according to species.

Note that you are not limited to saturated models when doing mixture modeling. 
You can use a factor analysis model or a regression model or any other kind of model. 
See Example 36 for a demonstration of mixture modeling with a regression model.
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E Draw the following path diagram. (This path diagram is saved as Ex34-a.amw.)

E From the menus, choose View Analysis Properties.
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E Select Estimate means and intercepts (a check mark will appear next to it). 

Fitting the Model

E Click  on the toolbar.

or

E From the menus, choose Analyze Bayesian Estimation.

Note: The  button is disabled because, in mixture modeling, you can perform only 
Bayesian estimation.
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After the Bayesian SEM window opens, wait until the unhappy face  changes into 
a happy face . The table of estimates in the Bayesian SEM window should look 
something like this:

The Bayesian SEM window displays all of the parameter estimates that you would get 
in an ordinary three-group analysis. The table displays the results for one group at a 
time. You can switch from one group to another by clicking the tabs at the top of the 
table. In this example, the model parameters include only means, variances, and 
covariances. In a more complicated model, there would also be estimates of regression 
weights and intercepts.
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In a mixture modeling analysis, you also get an estimate of the proportion of the 
population that lies in each group. The preceding figure shows that the proportion of 
setosa flowers in the population is estimated to be 0.333. (It should be pointed out that 
it was by design that the sample contained equal numbers of setosa, versicolor, and 
virginica flowers. It is therefore not meaningful in this example to draw inferences 
about population proportions from the sample. Nevertheless, we will treat species here 
as a random variable in order to demonstrate how such inferences can be made.)

To view the posterior distribution of a population proportion, right-click the row that 
contains the proportion and choose Show Posterior from the pop-up menu.
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The Posterior window shows that the proportion of flowers that belong to the setosa 
species is almost certainly between 0.25 and 0.45. It looks like there is about a 50–50 
chance that the proportion is somewhere between 0.3 and 0.35.

Classifying Individual Cases

To obtain probabilities of group membership for each individual flower:

E Click the Posterior Predictive button .

or

E From the menus, choose View Posterior Predictive.
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For each flower, the Posterior Predictive Distributions window shows the probability 
that that flower is setosa, versicolor, or virginica.

For the first 50 flowers (the ones that actually are setosa), the probability of 
membership in the setosa group is nearly 1. We expected that result because the setosa 
flowers were clearly separated from flowers of other species in the scatterplot shown 
earlier.

Most of the versicolor flowers (starting with case number 51) were also correctly 
classified. For example, flower number 51 has posterior probability 0.95 of being 
versicolor. However, classification errors do occur. Case number 71, for example, is 
misclassified. It is a versicolor flower, but it is estimated to have a 0.74 probability of 
being virginica.
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Latent Structure Analysis

It was mentioned earlier that you are not limited to saturated models when doing 
mixture modeling. You can use a factor analysis model, a regression model, or any 
model at all. You may want to become familiar with an important variation of the 
saturated model. Latent structure analysis (Lazarsfeld and Henry, 1968) is a variation 
of mixture modeling in which the measured variables are required to be independent 
within each group. When the measured variables are multivariate normal, they are 
required to be uncorrelated.

E To require that the measured variables be uncorrelated, delete the double-headed arrow 
in the path diagram of the saturated model. (This path diagram is saved as Ex34-
b.amw.)

E Click the Bayesian button  to perform the latent structure analysis. The results of the 
latent structure analysis will not be presented here.
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35
Mixture Modeling without 
Training Data

Introduction

Mixture modeling is appropriate when you have a model that is incorrect for an entire 
population, but where the population can be divided into subgroups in such a way that 
the model is correct in each subgroup.

When Amos performs mixture modeling, it allows you to assign some cases to 
groups before the analysis starts. Example 34 shows how to do that. In the present 
example, all cases are unclassified at the start of the mixture modeling analysis.
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About the Data

This example uses the Anderson (1935) iris data that was used in Example 34. This 
time, however, we will not use the iris3.sav dataset, which contains species information 
for 30 of the 150 flowers. Instead, we will use the iris2.sav dataset, which contains no 
species information at all. That is the difference between Example 34 and the present 
example: In Example 34, some cases were pre-classified; in the present example, no 
cases are pre-classified. The following figure shows a portion of the iris2.sav dataset.

Notice that the dataset contains a Species column, even though that column is empty. 
It is important that the Species column be present even if it contains no values. This is 
because Amos allows for the possibility that you might already know the species of 
some cases (as in Example 34). The variable that is used for classifying cases does not 
actually have to be named Species. Any variable name will do. The variable does, 
however, have to be a string (non-numeric) variable.
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Performing the Analysis

E From the menus, choose File New to start a new path diagram.

E From the menus, choose Analyze Manage Groups.

E Click New to create a second group.

E Click New once more to create a third group.

E Click Close.
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This example fits a three-group mixture model. When you aren’t sure how many 
groups there are, you can run the program multiple times. Run the program once to fit 
a two-group model, then again to fit a three-group model, and so on.

Specifying the Data File

E From the menus, choose File Data Files.

E Click Group number 1 to select the first row.

E Click File Name, select the iris2.sav file that is in the Amos Examples directory, and 
click Open.
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E Click Grouping Variable and double-click Species in the Choose a Grouping Variable 
dialog. This tells the program that the Species variable will be used to distinguish one 
group from another.

E Repeat the preceding steps for Group number 2, specifying the same data file (iris2.sav) 
and the same grouping variable (Species).
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E Repeat the preceding steps once more for Group number 3, specifying the same data file 
(iris2.sav) and the same grouping variable (Species).

E Select Assign cases to groups (a check mark will appear next to it).
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So far, this has been just like any ordinary multiple-group analysis except for the check 
mark next to Assign cases to groups. That check mark turns this into a mixture 
modeling analysis. The check mark tells Amos to assign a flower to a group if the 
grouping variable in the data file does not already assign it to a group. Notice that it 
was not necessary to click Group Value to specify a value for the grouping variable. The 
data file contains no values for the grouping variable (Species), so the program 
automatically constructed the following Species values for the three groups: Cluster1, 
Cluster2, and Cluster3. 

E Click OK to close the Data Files dialog.

Specifying the Model

We will use a saturated model for the variables PetalLength and PetalWidth. The 
scatterplot in Example 34 suggests that these two variables will allow the program to 
do a good job of classifying the flowers according to species.

Note that you are not limited to saturated models when doing mixture modeling. 
You can use a factor analysis model, a regression model, or any other kind of model. 
Example 36 demonstrates mixture modeling with a regression model.

E Draw the following path diagram:

E From the menus, choose View Analysis Properties.
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E Select Estimate means and intercepts (a check mark will appear next to it).
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Constraining the Parameters

In this example, variances and covariances will be required to be invariant across 
groups. This is the assumption of homogeneity of variances and covariances that is 
often made in discriminant analysis and some kinds of clustering. In principle, the 
assumption of homogeneity of variances and covariances is not necessary in mixture 
modeling. The reason we will make the assumption here is that, for this example, the 
algorithm in Amos fails without that assumption. (It should be noted that the scatterplot 
in Example 34 suggests that the assumption is violated.)

E Right-click PetalLength in the path diagram, choose Object Properties from the pop-up 
menu, and enter the parameter name, v1, in the Variance text box.

While the Object Properties  dialog is still open, click PetalWidth in the path diagram.

E While the Object Properties dialog is still open, click PetalWidth in the path diagram.
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E In the Object Properties dialog, enter the parameter name, v2, in the Variance text box.

E While the Object Properties dialog is still open, click the double-headed arrow that 
represents the covariance between PetalLength and PetalWidth.

E In the Object Properties dialog, enter the parameter name, c12, in the Covariance text 
box.
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The path diagram should now look like the following figure. (This path diagram is 
saved as Ex35-a.amw.)

Fitting the Model

E Click  on the toolbar.

or

E From the menus, choose Analyze Bayesian Estimation.

Note: The  button is disabled because, in mixture modeling, you can perform only 
Bayesian estimation.

After the Bayesian SEM window opens, wait until the unhappy face  changes into 
a happy face . The table of estimates in the Bayesian SEM window should then look 
something like this:
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The Bayesian SEM window displays all of the parameter estimates that you would get 
in an ordinary three-group analysis. The table displays the estimates for one group at a 
time. You can switch from one group to another by clicking the tabs at the top of the 
table. In this example, the model parameters include only means, variances, and 
covariances. In a more complicated model, there would also be estimates of regression 
weights and intercepts.

In a mixture modeling analysis, you also get an estimate of the proportion of the 
population that lies in each group. In the preceding figure, the proportion of setosa 
flowers in the population is estimated to be 0.306.
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E To view the posterior distribution of a population proportion, right-click the row that 
contains the proportion and choose Show Posterior from the pop-up menu.
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The graph of the posterior distribution in the Posterior window shows that the 
proportion of flowers that belong in Group number 1 is certainly between 0.15 and 
0.45. There is a very high probability that the proportion is between 0.25 and 0.35.

Classifying Individual Cases

To obtain probabilities of group membership for each individual flower:

E Click the Posterior Predictive button .

or

E From the menus, choose View Posterior Predictive.

For each flower, the Posterior Predictive Distributions window shows the probability 
that the value of the Species variable is Cluster1, Cluster2, or Cluster3.
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The first 50 cases, which we know to be examples of setosa, are placed in Group 
number 3 with a probability of 1, so Group number 3 clearly contains setosa flowers. 
Cases 51 through 100 fall mainly into Group number 2, so Group number 2 clearly 
contains versicolor flowers. Similarly, although the preceding figure does not show it, 
cases 101 through 150 are assigned mainly to Group number 1, so Group number 1 
clearly contains virginica flowers.
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Latent Structure Analysis

There is a variation of mixture modeling called latent structure analysis in which 
observed variables are required to be independent within each group.

E To require that PetalLength and PetalWidth be uncorrelated and therefore (because 
they are multivariate normally distributed) independent, remove the double-headed 
arrow that connects them in the path diagram. The resulting path diagram is shown 
here. (This path diagram is saved as the file, Ex35-b.amw.)

E Optionally, remove the constraints on the variances by deleting the parameter names, 
v1 and v2. (The resulting path diagram is saved as Ex35-c.amw.)

E After deleting the double-headed arrow and possibly removing the constraints on the 
variances, click the Bayesian button  to perform the latent structure analysis. The 
results of the latent structure analysis will not be reported here.
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Label Switching

If you attempt to replicate the analysis in this example, it is possible that you will get 
the results that are reported here but with the group names permuted. The results 
reported here for Group number 1 might correspond to the results you get for Group 
number 2 or Group number 3. This is sometimes called label switching (Chung, 
Loken, and Schafer, 2004). Label switching is not really a problem unless it occurs 
during the course of a single analysis. Unfortunately, label switching can in fact occur 
in the middle of an analysis. When label switching occurs, it is usually revealed by 
trace plots for individual parameters. To display a trace plot during Bayesian 
estimation:

E Right-click a parameter in the Bayesian SEM window and choose Show Posterior from 
the pop-up menu.

E In the Posterior window, select Trace.

Label switching did not occur in the analysis of the present example. The following 
figure, from another analysis, shows a trace plot that is typical of label switching. This 
trace plot came from an analysis of data with two clusters of cases. In one cluster, the 
mean of a variable called X was about 4. In the other cluster, the mean of the X variable 
was about 17. The trace plot shows that, in the group called Group number 1, the 
sampled values of the mean of X stayed close to 4 most of the time until about the 
5,000-th iteration of the MCMC algorithm. At about the 5,000-th iteration, sampled 
values started fluctuating around 17. This abrupt shift in the trace plot is evidence that 
the group labels (Group number 1 and Group number 2) were switched at about the 
5,000-th iteration. The trace plot shows that this label switching occurred several times 
during the first 20,000 iterations of the MCMC algorithm.



Label switching can be revealed by a multi-model posterior distribution for one or 
more parameters. The preceding trace plot corresponds to the following posterior 
distribution estimate.

The preceding graph shows that the mean of a parameter’s posterior distribution may 
not be a meaningful estimate in a mixture modeling analysis when label switching 
occurs. Some methods for preventing label switching have been proposed (Celeux, 
Hurn, and Robert, 2000; Frühwirth-Schnatter, 2004; Jasra, Holmes, and Stephens, 
2005; Stephens, 2000). Chung, Loken, and Schafer (2004) suggest that pre-assigning 
even one or two cases to groups can be effective in eliminating label switching. Amos 
allows pre-assigning cases to groups, as shown in Example 34. Amos does not 
implement any other method for preventing label switching.
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36
Mixture Regression Modeling

Introduction

Mixture regression modeling (Ding, 2006) is appropriate when you have a regression 
model that is incorrect for an entire population, but where the population can be 
divided into subgroups in such a way that the regression model is correct in each 
subgroup.

About the Data

Two artificial datasets will be used to explain mixture regression.

First Dataset

The following dataset is in the file DosageAndPerformance1.sav. Dosage is the 
intensity of some treatment. Performance is just some performance measure. Group 
is a string (non-numeric) variable whose role in mixture regression analysis will be 
explained later.
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A scatterplot of dosage and performance shows two distinct groups of people in the 
sample. In one group, performance improves as dosage goes up. In the other group, 
performance gets worse as dosage goes up.
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It would be a mistake to try to fit a single regression line to the whole sample. On the 
other hand, two straight lines, one for each group, would fit the data well. This is a job 
for mixture regression modeling. A mixture regression analysis would attempt to 
divide the sample up into groups and to fit a separate regression line to each group.

Second Dataset

The following dataset, in the file DosageAndPerformance2.sav, also contains data on 
the variables dosage, performance, and group.

Again, a scatterplot of the data shows evidence of two groups, with each group 
requiring its own regression line. In either group by itself, an increase of one unit in 
dosage is associated with an increase of about two units in performance, so that the 
slope of the regression line is about 2 within each group. On the other hand, the two 
groups have different intercepts. At any particular dosage level, performance is 5 
points or so higher in one group than in the other. A mixture regression analysis of this 
dataset would attempt to divide the sample up into groups and to fit a separate 
regression line to each group.
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The Group Variable in the Dataset

Both of the datasets just described include a string (non-numeric) variable called group 
that contains no data. In a mixture regression analysis, Amos will use the group 
variable to classify individual cases. (The fact that the variable is called group is not 
important. Any variable name will do; however, it does have to be a string variable.) 

If some cases have already been assigned to groups before the analysis starts, you 
can put the group names in the group column of the dataset. For example, if you know 
ahead of time (before the mixture regression analysis starts) that the sample contains 
high performers and low performers and you know that the first two people in the 
sample are high performers and that the next three people are low performers, then you 
can enter that information in the group column of the data table in the following way:
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The program will then use the five cases that have been pre-classified to assist in 
classifying the remaining cases. Pre-assigning selected individual cases to groups is 
mentioned here only as a possibility. In the present example, no cases will be pre-
assigned to groups.

Performing the Analysis

Only the DosageAndPerformance2.sav dataset will be analyzed in this example.

E From the menus, choose File New to start a new path diagram.

E From the menus, choose Analyze Manage Groups.



582

Example 36

E Click New to create a second group.

E Click Close.

This example fits a two-group mixture regression model. When you aren’t sure how 
many groups there are, you can run the program multiple times. Run the program once 
to fit a two-group model, then again to fit a three-group model, and so on.
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Specifying the Data File

E From the menus, choose File Data Files.

E Click Group number 1 to select that row.

E Click File Name, select the DosageAndPerformance2.sav file that is in the Amos 
Examples directory, and click Open.

E Click Grouping Variable and double-click group in the Choose a Grouping Variable 
dialog. This tells the program that the variable called group will be used to distinguish 
one group from another.
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E Repeat the preceding steps for Group number 2, specifying the same data file 
(DosageAndPerformance2.sav) and the same grouping variable (group).
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E Select Assign cases to groups (a check mark will appear next to it). 

So far, this has been just like any ordinary multiple-group analysis except for the check 
mark next to Assign cases to groups. That check mark turns this into a mixture 
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modeling analysis. The check mark tells Amos to assign a case to a group if the 
grouping variable in the data file does not already assign it to a group. Notice that it 
was not necessary to click Group Value to specify a value for the grouping variable. The 
data file contains no values for the grouping variable (group), so the program 
automatically constructed values for the group variable: Cluster1 for cases in Group 
number 1, and Cluster2 for cases in Group number 2.

E Click OK to close the Data Files dialog.

Specifying the Model

E Draw a path diagram for the regression model, as follows. (This path diagram is saved 
as Ex36-a.amw.)

E From the menus, choose View Analysis Properties.

E Select Estimate means and intercepts (a check mark will appear next to it). 
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Fitting the Model

E Click  on the toolbar.

or

E From the menus, choose Analyze Bayesian Estimation.

Note: The  button is disabled because, in mixture modeling, you can perform only 
Bayesian estimation.
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After the Bayesian SEM window opens, wait until the unhappy face  changes into 
a happy face . The table of estimates in the Bayesian SEM window should then look 
something like this:

The Bayesian SEM window contains all of the parameter estimates that you would get 
in an ordinary multiple-group regression analysis. There is a separate table of estimates 
for each group. You can switch from group to group by clicking the tabs just above the 
table of estimates.
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The bottom row of the table contains an estimate of the proportion of the population 
that lies in an individual group. The preceding figure, which displays estimates for 
Group number 1, shows that the proportion of the population in Group number 1 is 
estimated to be 0.247. To see the estimated posterior distribution of that population 
proportion, right-click the proportion’s row in the table and choose Show Posterior 
from the pop-up menu.
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The graph in the Posterior window shows that the proportion of the population in 
Group number 1 is practically guaranteed to be somewhere between 0.15 and 0.35.

Let’s compare the regression weight and the intercept in Group number 1 with the 
corresponding estimates in Group number 2. In Group number 1, the regression weight 
estimate is 2.082 and the intercept estimate is 5.399. In Group number 2, the regression 
weight estimate (1.999) is about the same as in Group number 1 while the intercept 
estimate (9.955) is substantially higher than in Group number 1.
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Classifying Individual Cases

To obtain probabilities of group membership for each individual case:

E Click the Posterior Predictive button .

or

E From the menus, choose View Posterior Predictive.

For each case, the Posterior Predictive Distributions window shows the probability that 
the group variable takes on the value Cluster1 or Cluster2.  Case 1 is estimated to have 
a 0.88 probability of being in Group number 1 and a 0.12 probability of being in Group 
number 2. Recall that the first group has an intercept of about 5.399 while the second 
group has an intercept of about 9.955, so Group number 1 is the low performing group. 
Therefore, there is an 88 percent chance that the first person in the sample is in the low 
performing group and a 12 percent chance that that person is in the high performing 
group.



593

Mixture Regression Model ing

Improving Parameter Estimates

You can improve the parameter estimates (and also improve Amos’s ability to form 
clusters) by reducing the number of parameters that need to be estimated. As we have 
seen, the slope of the regression line is about the same for the two groups. Also, the 
variability about each regression line appears to be about the same for the two groups. 
It is possible to incorporate into the mixture modeling analysis the hypothesis that the 
slopes and the error variances are the same for the two groups, thereby reducing the 
number of distinct parameters to be estimated. To do this:

E On the path diagram, right-click the single-headed arrow that connects dosage and 
performance, choose Object Properties from the pop-up menu, and enter the parameter 
name, b, in the Regression weight text box.

E While the Object Properties dialog is still open, click E1 in the path diagram.

E In the Object Properties dialog, enter the parameter name, v, in the Variance text box.
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The path diagram should now look like the following figure. (This path diagram is 
saved as Ex36-b.amw.)

After constraining the slope and error variance to be the same for the two groups, you 
can repeat the mixture modeling analysis by clicking the Bayesian button . The 
results of that analysis will not be presented here.
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Prior Distribution of Group Proportions

For the prior distribution of group proportions, Amos uses a Dirichlet distribution with 
parameters that you can specify. By default, the Dirichlet parameters are 4, 4, ….

E To specify the Dirichlet parameters, right-click on a group proportion’s estimate in the 
Bayesian SEM window and choose Show Prior from the pop-up menu.



596

Example 36

Label Switching

It is possible that the results reported here for Group number 1 will match the results 
that you get for Group number 2, and that the results reported here for Group number 
2 will match those that you get for Group number 1. In other words, your results may 
match the results reported here, but with the group names reversed. This is sometimes 
called label switching (Chung, Loken, and Schafer, 2004). Label switching is 
discussed further at the end of Example 35.
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Example

37
Using Amos Graphics without 
Drawing a Path Diagram

Introduction

People usually specify models in Amos Graphics by drawing path diagrams; however, 
Amos Graphics also provides a non-graphical method for model specification. If you 
don't want to draw a path diagram, you can specify a model by entering text in the 
form of a Visual Basic or C# program. In such a program, each object in a path 
diagram (for example, each rectangle, ellipse, single-headed arrow, double-headed 
arrow, and figure caption) corresponds to a single program statement. Usually, a 
program statement is one line of text.

Here are some reasons why you might choose to specify a model by entering text 
rather than by drawing a path diagram.

 Your model is so big that drawing its path diagram would be difficult.

 You prefer using a keyboard to using a mouse, or prefer working with text to 
working with graphics.

 You need to generate a lot of similar models that differ only in some detail such 
as the number of variables or the variable names. If you need to generate such 
models frequently, it can be efficient to automate the chore by creating a super 
program whose text output is a tailor-made Visual Basic or C# program that 
specifies the particular model that you want Amos to fit.

The present example shows how to specify a model in Amos Graphics by entering text 
rather than by drawing a path diagram.
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About the Data

The Holzinger and Swineford (1939) dataset from Example 8 is used for this example.

A Common Factor Model

The factor analysis model from Example 8 is used for this example. Whereas the model 
was specified in Example 8 by drawing its path diagram, the same model will be 
specified in the current example by writing a Visual Basic program.

Creating a Plugin to Specify the Model

E From the menus, choose Plugins Plugins.

E In the Plugins dialog, click Create.
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The Program Editor window opens.

E In the Program Editor window, change the Name and Description functions so that they 
return meaningful strings.

You may find it helpful at this point to refer to the first path diagram in Example 8. We 
are going to add one line to the Mainsub function for each rectangle, ellipse and arrow 
in the path diagram.
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E In the Program Editor, enter the line

pd.Observed("visperc")

as the first line in the Mainsub function.

If you save the plugin now, you can use it later on to draw a rectangle representing a 
variable called visperc. The rectangle will be drawn with arbitrary height and width at 
a random location in the path diagram. You can specify its height, width and location. 
For example,

pd.Observed("visperc", 400, 300, 200, 100)

draws a rectangle for a variable called visperc. The rectangle will be centered 400 
logical pixels from the left edge of the path diagram, 300 logical pixels from the top 
edge. It will be 200 logical pixels wide and 100 logical pixels high. (A logical pixel is 
1/96 of an inch.) The online help gives other variations of the Observed method.
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In this example, we will not specify the height, width or location of any path diagram 
objects.

E Enter the following additional lines in the Mainsub function so that the plugin will 
draw five more rectangles for the five remaining observed variables:

pd.Observed("cubes")
pd.Observed("lozenges")
pd.Observed("paragrap")
pd.Observed("sentence")
pd.Observed("wordmean")

E Enter the following lines so that the plugin will draw eight ellipses for the eight 
unobserved variables:

pd.Unobserved("err_v")
pd.Unobserved("err_c")
pd.Unobserved("err_l")
pd.Unobserved("err_p")
pd.Unobserved("err_s")
pd.Unobserved("err_w")
pd.Unobserved("spatial")
pd.Unobserved("verbal")
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E Enter the following lines so that the plugin will draw the 12 single-headed arrows:

pd.Path("visperc", "spatial", 1)
pd.Path("cubes", "spatial")
pd.Path("lozenges", "spatial")
pd.Path("paragrap", "verbal", 1)
pd.Path("sentence", "verbal")
pd.Path("wordmean", "verbal")

pd.Path("visperc", "err_v", 1)
pd.Path("cubes", "err_c", 1)
pd.Path("lozenges", "err_l", 1)
pd.Path("paragrap", "err_p", 1)
pd.Path("sentence", "err_s", 1)
pd.Path("wordmean", "err_w", 1)

Notice that in some of the lines above, the Path method has a third argument that is set 
equal to 1. This is how you fix a regression weight to a constant value of 1. See the 
online help for other variations of the Path method.

E Enter the following line so that the plugin will draw the double-headed arrow:

pd.Cov("spatial", "verbal")

E Enter the following line to reposition the objects in the path diagram so as to improve 
its appearance:

pd.Reposition()

As mentioned above, the simple forms of the Observed, Unobserved and Caption 
methods that are used in this example place objects at random positions in the path 
diagram. The Reposition method attempts to make the path diagram look better by 
rearranging objects. The Reposition method does not produce path diagrams of 
presentation quality. Far from it, in fact. On the other hand, Reposition usually 
improves a path diagram’s appearance substantially. In order to get objects in the path 
diagram sized and positioned exactly the way you want, you can use one of the 
following approaches.
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E Specify a height, width and location each time you use the Observed, Unobserved and 
Caption methods of the pd class. (See the online help for the Observed, Unobserved 
and Caption methods.)

or

E In your plugin, use the Reposition method to improve the positioning of objects. After 
running the plugin, use the drawing tools in the Amos Graphics toolbox to interactively 
move and resize the objects in the path diagram.

Controlling Undo Capability

E Enter the following line as the first line in the Mainsub function:

pd.UndoToHere

E Enter the following line as the last line in the Mainsub function:

pd.UndoResume

The UndoToHere method and the UndoResume method work together to ensure that 
the effect of running the plugin can be undone by one click of the Undo button.
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The Mainsub function now looks like this in the Program Editor:

This completes the plugin for specifying the factor analysis model from Example 8. 
Amos comes with a pre-written copy of the plugin in a file called Ex37a-plugin.vb. 
Language-specific versions of this file are saved in the folders 
%amosplugins%\Japanese and %amosplugins%\English. You can use one of the pre-
written language-specific plugins by copying it to the %amosplugins% folder.
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Compiling and Saving the Plugin

E Click the Check Syntax button on the toolbar in the Program Editor window. Any 
compilation errors will be displayed on the Syntax errors tab of the Program Editor 
window.

E After you fix any compilation errors, click Close in the Program Editor window. You 
will be asked if you want to save the file:

E Click Yes. The Save As dialog will be displayed.

E In the Save As dialog, type a filename for your plugin and click Save. Your plugin must 
be saved in the Save As dialog’s default folder location. If you have inadvertently 
changed the folder in the Save As dialog, you can change it back to the default by 
entering %amosplugins% as the folder name.
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After you have saved your plugin, its name, Example 37a, appears on the list of plugins 
in the Plugins window. (Recall that Example 37a is the string returned by the plugin’s 
Name function.)

E Close the Plugins window.

Using the Plugin

E From the menus, choose File New to start with an empty path diagram.

If you are asked whether you want to save your work, choose either Yes or No:
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E From the menus, choose Plugins Example 37a. The plugin generates the model’s path 
diagram, which is then displayed in the path diagram window. The following path 
diagram was generated during the preparation of this example. (You will almost 
certainly get a different path diagram because a random number generator plays a role 
in positioning the elements in the path diagram.)
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Other Aspects of the Analysis in Addition to Model 
Specification

In Example 8, the data file Grnt_fem.sav was specified interactively (by choosing
File Data Files on the menus). You can do the same thing here as well. As an 
alternative, you can specify the Grnt_fem.sav data file within the plugin by adding the 
following lines to the Mainsub function:

pd.SetDataFile(1, MiscAmosTypes.cDatabaseFormat.mmSPSS, _ 
Environment.GetEnvironmentVariable("examples") & "\grnt_fem.sav", "", "", 
"")

Similarly, in Example 8, standardized estimates were requested interactively (by 
choosing View Analysis Properties on the menus). As an alternative to requesting 
standardized estimates interactively, you can request them within a plugin by adding 
the following line to the Mainsub function:

pd.GetCheckBox("AnalysisPropertiesForm", "StandardizedCheck").Checked = True

Generally, any aspect of an analysis that can be specified interactively can be specified 
within a plugin by using the methods and properties of the pd class.

Defining Program Variables that Correspond to Model Variables

There are five pd methods that create an object in a path diagram: Observed, 
Unobserved, Path, Cov and Caption. Each of these methods returns a reference to the 
object that it creates. For example, the Observed method creates an observed variable 
in the path diagram and also returns a reference to that observed variable. Instead of 
writing the lines

pd.Observed("wordmean")
pd.Unobserved("verbal")

to create an observed variable called wordmean and an unobserved variable called 
verbal, you can write the following lines (in Visual Basic):

Dim wordmean As PDElement = pd.Observed("wordmean")
Dim verbal As PDElement = pd.Unobserved("verbal")
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Then you can use the program variable wordmean to refer to the model variable called 
wordmean, and use the program variable verbal to refer to the model variable called 
verbal. If you want to draw a single-headed arrow from the verbal variable to the 
wordmean variable, you can write either

pd.Path(wordmean, verbal)

or

pd.Path(“wordmean”, "verbal")

The advantage of the unquoted version over the quoted version is that, with the 
unquoted version, typing errors are likely to be detected when you click the Check 
Syntax button. With the quoted version, typing errors cannot be detected until you use 
the plugin, if they are detected at all.

The file Ex37b-plugin.vb contains a plugin that has the same functionality as Ex37a-
plugin.vb. The difference is that Ex37b-plugin.vb uses Visual Basic variables to refer 
to model variables. Language-specific versions of Ex37b-plugin.vb are saved in the 
folders %amosplugins%\Japanese and %amosplugins%\English. You can use one of 
the pre-written language-specific plugins by copying it to the %amosplugins% folder.
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38
Simple User-Defined Estimands I

Introduction

This example shows how to estimate user-defined functions of model parameters 
along with bootstrap standard errors, confidence intervals, and significance tests. In 
this example, a single user-defined function is estimated—an indirect effect.

The example demonstrates a simplified approach to the estimation of user-defined 
functions of parameters. The simplified version is limited to estimands that can be 
defined by a single expression. A more general version (not demonstrated here) of 
Amos's user-defined estimand capability allows the estimands to be defined by a 
program of arbitrary length and complexity. The more general version is documented 
in the online help under the topic “CValue Class Reference” and is demonstrated in 
videos at http://amosdevelopment.com/features/user-defined/user-defined-
general/index.html.

http://amosdevelopment.com/features/user-defined/user-defined-general/index.html
http://amosdevelopment.com/features/user-defined/user-defined-general/index.html
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The Wheaton Data Revisited

Example 6 described three alternative models for the Wheaton et al. (1977) data. Here, 
we re-examine Model B from Example 6. The following path diagram, which is in the 
file Ex38.amw, shows Model B from Example 6, with some parameter names added.

 

Estimating an Indirect Effect

Five of the regression weights in this model have been named A, B, C, D, and E, in 
order to make it easy to discuss the indirect effect of ses on powles71. There are two 
such indirect effects: the product AB and the product CDB. You can estimate the sum 
of the two indirect effects, AB + CDB, by clicking View > Analysis Properties > Output 
and putting a check mark next to Indirect, direct & total effects. This capability is built 
into Amos and does not require you to specify a user-defined estimand. Suppose, 
however, that you want to estimate both of the individual indirect effects, AB and CDB, 
as well as their sum. All three can be estimated as user-defined estimands in the 
following way.
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E Click Not estimating any user-defined estimand on the status bar in the lower-left corner 
of the Amos Graphics window. Then click Define new estimands from the pop-up menu.
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E In the new window that opens, enter three lines to define three custom estimands:

The names of the three custom estimands are Indirect_AB, Indirect_CDB and Sum. 
You can make up other names instead. Names for estimands must be made up of letters 
of the alphabet, numbers, and the underscore character. The first character must be 
alphabetic. Uppercase and lowercase are not distinguished, so that if you call an 
estimand Abc you cannot call another estimand abc.

The two-character sequence "p." is used as a prefix for parameter names. For example, 
"p.A" means "the parameter named A." The "p." prefixes can usually be omitted with 
some improvement in readability as shown here:
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One benefit of using the "p." prefix is that typing "p." displays a list of parameter names 
that you can choose from. In the following screenshot, double-clicking A in the 
parameter list has the same effect as typing "A" on the keyboard,

There is one situation where you must use the "p.": If you have a parameter named A 
and also a variable named A, then typing a plain “A” will be ambiguous. You will in 
that case have to type "p.A" for the parameter called A, or "v.A" for the variable called A,
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E Optionally, add lines and comments, as shown here:

E Click the Close button.

E  Click Yes in the following dialog.
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E In the Save As dialog, type indirect effects in the File name box. Then click the Save 
button.
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E Click View > Analysis Properties > Bootstrap, and put check marks next to Perform 
bootstrap and Bias-corrected confidence intervals. Also, since the data file contains 
sample moments and not raw data, put a check mark next to Monte Carlo (parameteric 
bootstrap).

E Click Analyze > Calculate Estimates.

E Click View > Text Output.
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E In the Amos Output window, double-click Estimates, then double-click Scalars, then 
click User-defined estimands.

The estimand called Indirect_AB is estimated to be –0.205. This is the product of the 
regression weight A (–0.212) and the regression weight B (0.971).
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E Click Bootstrap standard errors.

Indirect_AB is approximately normally distributed with a standard error of about 
0.048.

E Click Bootstrap Confidence.
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The population value of the Indirect_AB is between –0.283 and –0.118 with 90% 
confidence. The estimate of –0.205 has a p value of 0.013. It is significantly different 
from zero at the 0.05 level but not at the 0.01 level.

Estimating the Indirect Effect without Naming Parameters

If you plan on estimating a function of some parameters, it helps to name those 
parameters, as was done above. However, you don't have to name the parameters. The 
following steps show how to estimate the same indirect effect that we just estimated 
but without making use of parameter names.

E Click Estimating Simple indirect effect on the status bar in the lower-left corner of the 
Amos Graphics window. Then click Edit Simple indirect effects on the menu that pops 
up.



Wherever a parameter is referred to by name, substitute a description of the parameter 
as follows.

E Change "p.A" to "e.DirectEffect(alienation71,ses)"

E Change "p.B" to "e.DirectEffect(powles71,alienation71)"

E Change "p.C" to "e.DirectEffect(alienation67,ses)"

E Change "p.D" to "e.DirectEffect(alienation71,alienation67)"

After these substitutions, the specification for the custom estimands looks like this:

E  Close the window.

E Click Yes in the dialog that appears.

E Click Analyze > Calculate Estimates.

E Click View > Text Output. (The text output is the same as before.)
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39
Simple User-Defined Estimands II

Introduction

This example shows how to estimate the difference between two standardized 
regression weights, along with a bootstrap standard error, a confidence interval, and a 
significance test for the difference.

About the Data

Four quizzes were administered to a class of 39 students. The quizzes were 
approximately equally spaced throughout the semester. The file QuizComplete.txt 
contains the scores of the 22 students who took all four quizzes.

A Markov Model

The file Ex39.amw contains the following Markov model for scores on the four 
quizzes.
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The following path diagram shows the standardized regression weights estimated for 
this model.

Let's compare two standardized regression weights, say the weight for using q2 to 
predict q3, and the weight for using q3 to predict q4. The difference between the two 
estimates is about . Let's also get a standard error for that 
difference, along with a confidence interval and significance test for the difference.

E Click Not estimating any user-defined estimand on the status bar in the lower-left corner of 
the Amos Graphics window. Then click Define new estimands on the menu that pops up.

0.39 0.35– 0.04=
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E  In the window that opens, enter one line to specify the new estimand, as follows:

You can choose a name other than StandardizedWeightDiff if you wish.

E Click the Check Syntax button on the toolbar. If you have made no typing mistakes, the 
message “Syntax is OK” will be displayed in the Description box.

E Close the window.

E  Click Yes in the following dialog.
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E In the Save As dialog, type StandardizedDifference in the File name box. Then click 
the Save button. 
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E Click View > Analysis Properties > Bootstrap, and put check marks next to Perform 
bootstrap and Bias-corrected confidence intervals.

E Click Analyze > Calculate Estimates.

E Click View > Text Output.



E In the Amos Output window, double-click Estimates, then double-click Scalars, then 
click User-defined estimands.

The estimand called StandardizedWeightDiff is estimated to be 0.047.
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E Click Bootstrap standard errors.

The difference is approximately normally distributed with a standard error of about 
0.426.
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E Click Bootstrap Confidence.

The population value of the difference is between –0.679 and 0.688 with 90% 
confidence. The estimate of 0.047 is not significantly different from zero at any 
conventional significance level (p = 0.934).
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A
Notation

q = the number of parameters

 = the vector of parameters (of order q)

G = the number of groups

 = the number of observations in group g

 = the total number of observations in all groups combined

 = the number of observed variables in group g

 = the number of sample moments in group g. When means and intercepts are 
explicit model parameters, the relevant sample moments are means, 
variances, and covariances, so that . Otherwise, 
only sample variances and covariances are counted so that 

.

 = the number of sample moments in all groups combined

 = the number of degrees of freedom for testing the model

 = the r-th observation on the i-th variable in group g

 = the r-th observation in group g

 = the sample covariance matrix for group g



N g 

N N g 

g 1=

G

=

p g 

p* g 
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g 

S g 
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 = the covariance matrix for group g, according to the model

 = the mean vector for group g, according to the model

 = the population covariance matrix for group g

 = the population mean vector for group g

 = the  distinct elements of  arranged in a single column 
vector

r = the non-negative integer specified by the ChiCorrect method. By default r = G. 
When the Emulisrel6 method is used, r = G and cannot be changed by using 
ChiCorrect.

n = N – r 

 = the vector of order p containing the sample moments for all groups; that is,  
contains the elements of  and also (if means and intercepts are 
explicit model parameters) .

 = the vector of order p containing the population moments for all groups; that is, 
 contains the elements of  and also (if means and intercepts 

are explicit model parameters) . The ordering of the elements of 
 must match the ordering of the elements of .

 = the vector of order p containing the population moments for all groups 
according to the model; that is,  contains the elements of 

 and also (if means and intercepts are explicit model 
parameters) . The ordering of the elements of  must 
match the ordering of the elements of .

 = the function (of g) that is minimized in fitting the model to the sample

 = the value of g that minimizes 
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B
Discrepancy Functions

Amos minimizes discrepancy functions (Browne, 1982, 1984) of the form:

(D1)

Different discrepancy functions are obtained by changing the way f is defined. If 
means and intercepts are unconstrained and do not appear as explicit model 
parameters,  and  will be omitted and f will be written .

The discrepancy functions  and  are obtained by taking f to be:

Except for an additive constant that depends only on the sample size,  is –2 times 
the Kullback-Leibler information quantity (Kullback and Leibler, 1951). Strictly 
speaking,  and  do not qualify as discrepancy functions according to 
Browne’s definition because .

For maximum likelihood estimation (ML), , and  are obtained by taking f to be:
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(D2)

For generalized least squares estimation (GLS), , and  are obtained by 
taking f to be:

(D3)

For asymptotically distribution-free estimation (ADF), , and  are obtained 
by taking f to be:

(D4)

where the elements of  are given by Browne (1984, Equations 3.1–3.4):
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For scale-free least squares estimation (SLS), , and  are obtained by taking 
f to be:

(D5)

where .

For unweighted least squares estimation (ULS), , and  are obtained by 
taking f to be:

(D6)

The Emulisrel6 method in Amos can be used to replace (D1) with:

(D1a)

F is then calculated as .

When G = 1 and r = 1, (D1) and (D1a) are equivalent, giving:

For maximum likelihood, asymptotically distribution-free, and generalized least 
squares estimation, both (D1) and (D1a) have a chi-square distribution for correctly 
specified models under appropriate distributional assumptions. Asymptotically, (D1) 
and (D1a) are equivalent; however, both formulas can exhibit some inconsistencies in 
finite samples. 
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Suppose you have two independent samples and a model for each. Furthermore, 
suppose that you analyze the two samples simultaneously, but that, in doing so, you 
impose no constraints requiring any parameter in one model to equal any parameter in 
the other model. Then, if you minimize (D1a), the parameter estimates obtained from 
the simultaneous analysis of both groups will be the same as from separate analyses of 
each group alone. 

Furthermore, the discrepancy function (D1a) obtained from the simultaneous 
analysis will be the sum of the discrepancy functions from the two separate analyses. 
Formula (D1) does not have this property when r is nonzero. Using formula (D1) to do 
a simultaneous analysis of the two groups will give the same parameter estimates as 
two separate analyses, but the discrepancy function from the simultaneous analysis 
will not be the sum of the individual discrepancy functions.

On the other hand, suppose you have a single sample to which you have fitted some 
model using Amos. Now suppose that you arbitrarily split the sample into two groups 
of unequal size and perform a simultaneous analysis of both groups, employing the 
original model for both groups and constraining each parameter in the first group to be 
equal to the corresponding parameter in the second group. If you have minimized (D1) 
in both analyses, you will get the same results in both. However, if you use (D1a) in 
both analyses, the two analyses will produce different estimates and a different 
minimum value for F.

All of the inconsistencies just pointed out can be avoided by using (D1) with the 
choice r = 0, so that (D1) becomes:
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C
Measures of Fit

Model evaluation is one of the most unsettled and difficult issues connected with 
structural modeling. Bollen and Long (1993), MacCallum (1990), Mulaik, et al. 
(1989), and Steiger (1990) present a variety of viewpoints and recommendations on 
this topic. Dozens of statistics, besides the value of the discrepancy function at its 
minimum, have been proposed as measures of the merit of a model. Amos calculates 
most of them.

Fit measures are reported for each model specified by the user and for two 
additional models called the saturated model and the independence model. 

 In the saturated model, no constraints are placed on the population moments. The 
saturated model is the most general model possible. It is a vacuous model in the 
sense that it is guaranteed to fit any set of data perfectly. Any Amos model is a 
constrained version of the saturated model. 

 The independence model goes to the opposite extreme. In the independence 
model, the observed variables are assumed to be uncorrelated with each other. 
When means are being estimated or constrained, the means of all observed variables 
are fixed at 0. The independence model is so severely and implausibly constrained 
that you would expect it to provide a poor fit to any interesting set of data. 

It frequently happens that each one of the models that you have specified can be so 
constrained as to be equivalent to the independence model. If this is the case, the 
saturated model and the independence model can be viewed as two extremes between 
which your proposed models lie.

For every estimation method except maximum likelihood, Amos also reports fit 
measures for a zero model, in which every parameter is fixed at 0.

PCLOSE
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Measures of Parsimony

Models with relatively few parameters (and relatively many degrees of freedom) are 
sometimes said to be high in parsimony, or simplicity. Models with many parameters 
(and few degrees of freedom) are said to be complex, or lacking in parsimony. This use 
of the terms simplicity and complexity does not always conform to everyday usage. For 
example, the saturated model would be called complex, while a model with an 
elaborate pattern of linear dependencies but with highly constrained parameter values 
would be called simple.

While one can inquire into the grounds for preferring simple, parsimonious models 
(such as Mulaik, et al., 1989), there does not appear to be any disagreement that 
parsimonious models are preferable to complex ones. When it comes to parameters, all 
other things being equal, less is more. At the same time, well-fitting models are 
preferable to poorly fitting ones. Many fit measures represent an attempt to balance 
these two conflicting objectives—simplicity and goodness of fit.

In the final analysis, it may be, in a sense, impossible to define one best way to 
combine measures of complexity and measures of badness-of-fit in a single 
numerical index, because the precise nature of the best numerical trade-off 
between complexity and fit is, to some extent, a matter of personal taste. The 
choice of a model is a classic problem in the two-dimensional analysis of 
preference. (Steiger, 1990, p. 179)

NPAR 

NPAR is the number of distinct parameters (q) being estimated. For example, two 
regression weights that are required to be equal to each other count as one parameter, 
not two.

Note: Use the \npar text macro to display the number of parameters in the output path 
diagram.

DF

DF is the number of degrees of freedom for testing the model

qpd df
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where p is the number of sample moments and q is the number of distinct parameters. 
Rigdon (1994a) gives a detailed explanation of the calculation and interpretation of 
degrees of freedom.

Note: Use the \df text macro to display the degrees of freedom in the output path 
diagram.

PRATIO

The parsimony ratio (James, Mulaik, and Brett, 1982; Mulaik, et al., 1989) expresses 
the number of constraints in the model being evaluated as a fraction of the number of 
constraints in the independence model

where d is the degrees of freedom of the model being evaluated and  is the degrees 
of freedom of the independence model. The parsimony ratio is used in the calculation 
of PNFI and PCFI (see “Parsimony Adjusted Measures” on p. 652).

Note: Use the \pratio text macro to display the parsimony ratio in the output path 
diagram.

Minimum Sample Discrepancy Function

The following fit measures are based on the minimum value of the discrepancy.

CMIN

CMIN is the minimum value, , of the discrepancy, C (see Appendix B).

Note: Use the \cmin text macro to display the minimum value  of the discrepancy 
function C in the output path diagram.

P

P is the probability of getting as large a discrepancy as occurred with the present 
sample (under appropriate distributional assumptions and assuming a correctly 

id

d
PRATIO

di

Ĉ

Ĉ
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specified model). That is, P is a “p value” for testing the hypothesis that the model fits 
perfectly in the population.

One approach to model selection employs statistical hypothesis testing to eliminate 
from consideration those models that are inconsistent with the available data. 
Hypothesis testing is a widely accepted procedure, and there is a lot of experience in 
its use. However, its unsuitability as a device for model selection was pointed out early 
in the development of analysis of moment structures (Jöreskog, 1969). It is generally 
acknowledged that most models are useful approximations that do not fit perfectly in 
the population. In other words, the null hypothesis of perfect fit is not credible to begin 
with and will, in the end, be accepted only if the sample is not allowed to get too big.

If you encounter resistance to the foregoing view of the role of hypothesis testing in 
model fitting, the following quotations may come in handy. The first two predate the 
development of structural modeling and refer to other model fitting problems.

The power of the test to detect an underlying disagreement between theory and 
data is controlled largely by the size of the sample. With a small sample an 
alternative hypothesis which departs violently from the null hypothesis may still 
have a small probability of yielding a significant value of . In a very large 
sample, small and unimportant departures from the null hypothesis are almost 
certain to be detected. (Cochran, 1952)

If the sample is small, then the  test will show that the data are ‘not 
significantly different from’ quite a wide range of very different theories, while 
if the sample is large, the  test will show that the data are significantly 
different from those expected on a given theory even though the difference may 
be so very slight as to be negligible or unimportant on other criteria. (Gulliksen 
and Tukey, 1958, pp. 95–96)

Such a hypothesis [of perfect fit] may be quite unrealistic in most empirical work 
with test data. If a sufficiently large sample were obtained this statistic would, 
no doubt, indicate that any such non-trivial hypothesis is statistically untenable. 
(Jöreskog, 1969, p. 200)

...in very large samples virtually all models that one might consider would have 
to be rejected as statistically untenable.... In effect, a nonsignificant chi-square 
value is desired, and one attempts to infer the validity of the hypothesis of no 
difference between model and data. Such logic is well-known in various 
statistical guises as attempting to prove the null hypothesis. This procedure 
cannot generally be justified, since the chi-square variate v can be made small by 
simply reducing sample size. (Bentler and Bonett, 1980, p. 591)

2

2

2

2
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Our opinion...is that this null hypothesis [of perfect fit] is implausible and that it 
does not help much to know whether or not the statistical test has been able to 
detect that it is false. (Browne and Mels, 1992, p. 78).

See also “PCLOSE” on p. 645.

Note: Use the \p text macro for displaying this p value in the output path diagram.

CMIN/DF

CMIN/DF is the minimum discrepancy, , (see Appendix B) divided by its degrees 
of freedom.

Several writers have suggested the use of this ratio as a measure of fit. For every 
estimation criterion except for ULS and SLS, the ratio should be close to 1 for correct 
models. The trouble is that it isn’t clear how far from 1 you should let the ratio get 
before concluding that a model is unsatisfactory.

Rules of Thumb

...Wheaton et al. (1977) suggest that the researcher also compute a relative chi-
square ( ).... They suggest a ratio of approximately five or less ‘as 
beginning to be reasonable.’ In our experience, however,  to degrees of 
freedom ratios in the range of 2 to 1 or 3 to 1 are indicative of an acceptable fit 
between the hypothetical model and the sample data. (Carmines and McIver, 
1981, p. 80)

...different researchers have recommended using ratios as low as 2 or as high as 
5 to indicate a reasonable fit. (Marsh and Hocevar, 1985).

...it seems clear that a  ratio > 2.00 represents an inadequate fit. (Byrne, 
1989, p. 55).

Note: Use the \cmindf text macro to display the value of CMIN/DF in the output path 
diagram.

Ĉ

d

Ĉ

2 df
2

2 df
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FMIN

FMIN is the minimum value, , of the discrepancy, F (see Appendix B).

Note: Use the \fmin text macro to display the minimum value  of the discrepancy 
function F in the output path diagram.

Measures Based On the Population Discrepancy

Steiger and Lind (1980) introduced the use of the population discrepancy function as 
a measure of model adequacy. The population discrepancy function, , is the value 
of the discrepancy function obtained by fitting a model to the population moments 
rather than to sample moments. That is, 

in contrast to

Steiger, Shapiro, and Browne (1985) showed that, under certain conditions,  
has a noncentral chi-square distribution with d degrees of freedom and noncentrality 
parameter . The Steiger-Lind approach to model evaluation centers 
around the estimation of  and related quantities. 

This section of the User’s Guide relies mainly on Steiger and Lind (1980) and 
Steiger, Shapiro, and Browne (1985). The notation is primarily that of Browne and 
Mels (1992).

NCP

 is an estimate of the noncentrality parameter, 
.

The columns labeled LO 90 and HI 90 contain the lower limit ( ) and upper limit 
( ) of a 90% confidence interval, on . is obtained by solving

F̂

F̂

F0

F0 min F    0,  


=

F̂ min F    a,  


=

Ĉ nF̂=

 C nF= =
F0

NCP max Ĉ d– 0( )=
 C0 nF0= =

L
U L

  95.,ˆ  dC 
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for , and  is obtained by solving

for , where  is the distribution function of the noncentral chi-squared 
distribution with noncentrality parameter  and d degrees of freedom.

Note: Use the \ncp text macro to display the value of the noncentrality parameter 
estimate in the path diagram, \ncplo to display the lower 90% confidence limit, and 
\ncphi for the upper 90% confidence limit.

F0

 is an estimate of .

The columns labeled LO 90 and HI 90 contain the lower limit and upper limit of a 90% 
confidence interval for .

 

Note: Use the \f0 text macro to display the value of  in the output path diagram, \f0lo 
to display its lower 90% confidence estimate, and \f0hi to display the upper 90% 
confidence estimate.

RMSEA

 incorporates no penalty for model complexity and will tend to favor models with 
many parameters. In comparing two nested models,  will never favor the simpler 
model. Steiger and Lind (1980) suggested compensating for the effect of model 
complexity by dividing  by the number of degrees of freedom for testing the model. 
Taking the square root of the resulting ratio gives the population root mean square 

 U

  05.,|ˆ  dC 

  x  d( )


F0 F̂0 max Ĉ d–
n

------------- 0 
  NCP

n
-----------= = = 

n
--- F0=

F0

n
L 90 LO

n
U 90 HI

F̂0

F0
F0

F0
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error of approximation, called RMS by Steiger and Lind, and RMSEA by Browne and 
Cudeck (1993).

The columns labeled LO 90 and HI 90 contain the lower limit and upper limit of a 90% 
confidence interval on the population value of RMSEA. The limits are given by

Rule of Thumb

Practical experience has made us feel that a value of the RMSEA of about 0.05 or 
less would indicate a close fit of the model in relation to the degrees of freedom. 
This figure is based on subjective judgment. It cannot be regarded as infallible or 
correct, but it is more reasonable than the requirement of exact fit with the 
RMSEA = 0.0. We are also of the opinion that a value of about 0.08 or less for the 
RMSEA would indicate a reasonable error of approximation and would not want 
to employ a model with a RMSEA greater than 0.1. (Browne and Cudeck, 1993)

Note: Use the \rmsea text macro to display the estimated root mean square error of 
approximation in the output path diagram, \rmsealo for its lower 90% confidence 
estimate, and \rmseahi for its upper 90% confidence estimate.

d

F0RMSEA population 

d

F0
ˆ

RMSEA estimated 

d

nL 90 LO

d

nU 90 HI
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PCLOSE

 is a p value for testing the null hypothesis that the 
population RMSEA is no greater than 0.05. 

By contrast, the p value in the P column (see “P” on p. 639) is for testing the hypothesis 
that the population RMSEA is 0.

Based on their experience with RMSEA, Browne and Cudeck (1993) suggest that a 
RMSEA of 0.05 or less indicates a close fit. Employing this definition of close fit, 
PCLOSE gives a test of close fit while P gives a test of exact fit.

Note: Use the \pclose text macro to display the p value for close fit of the population 
RMSEA in the output path diagram.

Information-Theoretic Measures

Amos reports several statistics of the form  or , where k is some positive 
constant. Each of these statistics creates a composite measure of badness of fit 
( or ) and complexity (q) by forming a weighted sum of the two. Simple models 
that fit well receive low scores according to such a criterion. Complicated, poorly 
fitting models get high scores. The constant k determines the relative penalties to be 
attached to badness of fit and to complexity. 

The statistics described in this section are intended for model comparisons and not 
for the evaluation of an isolated model.

All of these statistics were developed for use with maximum likelihood estimation. 
Amos reports them for GLS and ADF estimation as well, although it is not clear that 
their use is appropriate there.

AIC

The Akaike information criterion (Akaike, 1973, 1987) is given by

PCLOSE 1  Ĉ .052nd d –=

05.RMSEA :0 H

0RMSEA :0 H

Ĉ kq+ F̂ kq+

Ĉ F̂

qC 2ˆAIC 

P \* Charformat
P \* Charformat
ECVI \* Charformat
ECVI \* Charformat
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See also “ECVI” on p. 647.

Note: Use the \aic text macro to display the value of the Akaike information criterion 
in the output path diagram.

BCC

The Browne-Cudeck (1989) criterion is given by

where  if the Emulisrel6 command has been used, or  if it 
has not.

BCC imposes a slightly greater penalty for model complexity than does AIC. BCC 
is the only measure in this section that was developed specifically for analysis of 
moment structures. Browne and Cudeck provided some empirical evidence suggesting 
that BCC may be superior to more generally applicable measures. Arbuckle (in 
preparation) gives an alternative justification for BCC and derives the above formula 
for multiple groups.

See also “MECVI” on p. 648.

Note: Use the \bcc text macro to display the value of the Browne-Cudeck criterion in 
the output path diagram.

BIC

The Bayes information criterion (Schwarz, 1978; Raftery, 1993) is given by the 
formula

In comparison to the AIC, BCC, and CAIC, the BIC assigns a greater penalty to model 
complexity and, therefore, has a greater tendency to pick parsimonious models. The 
BIC is reported only for the case of a single group where means and intercepts are not 
explicit model parameters.
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Note: Use the \bic text macro to display the value of the Bayes information criterion in 
the output path diagram.

CAIC

Bozdogan’s (1987) CAIC (consistent AIC) is given by the formula

CAIC assigns a greater penalty to model complexity than either AIC or BCC but not as 
great a penalty as does BIC. CAIC is reported only for the case of a single group where 
means and intercepts are not explicit model parameters. 

Note: Use the \caic text macro to display the value of the consistent AIC statistic in the 
output path diagram.

ECVI

Except for a constant scale factor, ECVI is the same as AIC.

The columns labeled LO 90 and HI 90 give the lower limit and upper limit of a 90% 
confidence interval on the population ECVI:

See also “AIC” on p. 645.

Note: Use the \ecvi text macro to display the value of the expected cross-validation 
index in the output path diagram, \ecvilo to display its lower 90% confidence estimate, 
and \ecvihi for its upper 90% confidence estimate.
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MECVI

Except for a scale factor, MECVI is identical to BCC.

where  if the Emulisrel6 command has been used, or  if it 
has not.

See also “BCC” on p. 646.

Note: Use the \mecvi text macro to display the modified ECVI statistic in the output 
path diagram.

Comparisons to a Baseline Model

Several fit measures encourage you to reflect on the fact that, no matter how badly your 
model fits, things could always be worse.

Bentler and Bonett (1980) and Tucker and Lewis (1973) suggested fitting the 
independence model or some other very badly fitting baseline model as an exercise to 
see how large the discrepancy function becomes. The object of the exercise is to put 
the fit of your own model(s) into some perspective. If none of your models fit very 
well, it may cheer you up to see a really bad model. For example, as the following 
output shows, Model A from Example 6 has a rather large discrepancy ( ) 
in relation to its degrees of freedom. On the other hand, 71.544 does not look so bad 
compared to 2131.790 (the discrepancy for the independence model).
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This things-could-be-much-worse philosophy of model evaluation is incorporated into 
a number of fit measures. All of the measures tend to range between 0 and 1, with 
values close to 1 indicating a good fit. Only NFI (described below) is guaranteed to be 
between 0 and 1, with 1 indicating a perfect fit. (CFI is also guaranteed to be between 
0 and 1, but this is because values bigger than 1 are reported as 1, while values less than 
0 are reported as 0.)

The independence model is only one example of a model that can be chosen as the 
baseline model, although it is the one most often used and the one that Amos uses. 
Sobel and Bohrnstedt (1985) contend that the choice of the independence model as a 
baseline model is often inappropriate. They suggest alternatives, as did Bentler and 
Bonett (1980), and give some examples to demonstrate the sensitivity of NFI to the 
choice of baseline model.

NFI

The Bentler-Bonett (1980) normed fit index (NFI), or 1 in the notation of Bollen 
(1989b) can be written

where  is the minimum discrepancy of the model being evaluated and 
 is the minimum discrepancy of the baseline model.

In Example 6, the independence model can be obtained by adding constraints to any 
of the other models. Any model can be obtained by constraining the saturated model. 
So Model A, for instance, with , is unambiguously in between the 
perfectly fitting saturated model ( ) and the independence model 
( ).

Model NPAR CMIN DF P CMIN/DF

Model A: No Autocorrelation 15 71.544 6 0.000 11.924
Model B: Most General 16 6.383 5 0.271 1.277
Model C: Time-Invariance 13 7.501 8 0.484 0.938
Model D: A and C Combined 12 73.077 9 0.000 8.120
Saturated model 21 0.000 0
Independence model 6 2131.790 15 0.000 142.119

bb F

F
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C
ˆ

ˆ
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1NFI 1 
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Looked at in this way, the fit of Model A is a lot closer to the fit of the saturated model 
than it is to the fit of the independence model. In fact, you might say that Model A has 
a discrepancy that is 96.6% of the way between the (terribly fitting) independence 
model and the (perfectly fitting) saturated model.

Rule of Thumb

Since the scale of the fit indices is not necessarily easy to interpret (e.g., the indices 
are not squared multiple correlations), experience will be required to establish 
values of the indices that are associated with various degrees of meaningfulness 
of results. In our experience, models with overall fit indices of less than 0.9 can 
usually be improved substantially. These indices, and the general hierarchical 
comparisons described previously, are best understood by examples. (Bentler and 
Bonett, 1980, p. 600, referring to both the NFI and the TLI)

Note: Use the \nfi text macro to display the normed fit index value in the output path 
diagram.

RFI

Bollen’s (1986) relative fit index (RFI) is given by

Model NPAR CMIN DF P CMIN/DF

Model A: No Autocorrelation 15 71.544 6 0.000 11.924
Model B: Most General 16 6.383 5 0.271 1.277
Model C: Time-Invariance 13 7.501 8 0.484 0.938
Model D: A and C Combined 12 73.077 9 0.000 8.120
Saturated model 21 0.000 0
Independence model 6 2131.790 15 0.000 142.119
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where  and d are the discrepancy and the degrees of freedom for the model being 
evaluated, and  and  are the discrepancy and the degrees of freedom for the 
baseline model. 

The RFI is obtained from the NFI by substituting F / d for F. RFI values close to 1 
indicate a very good fit.

Note: Use the \rfi text macro to display the relative fit index value in the output path 
diagram.

IFI

Bollen’s (1989b) incremental fit index (IFI) is given by:

where  and d are the discrepancy and the degrees of freedom for the model being 
evaluated, and  and  are the discrepancy and the degrees of freedom for the 
baseline model. IFI values close to 1 indicate a very good fit.

Note: Use the \ifi text macro to display the incremental fit index value in the output path 
diagram.

TLI

The Tucker-Lewis coefficient (2 in the notation of Bollen, 1989b) was discussed by 
Bentler and Bonett (1980) in the context of analysis of moment structures and is also 
known as the Bentler-Bonett non-normed fit index (NNFI). 

The typical range for TLI lies between 0 and 1, but it is not limited to that range. TLI 
values close to 1 indicate a very good fit.

Note: Use the \tli text macro to display the value of the Tucker-Lewis index in the output 
path diagram.
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CFI

The comparative fit index (CFI; Bentler, 1990) is given by

where , d, and NCP are the discrepancy, the degrees of freedom, and the 
noncentrality parameter estimate for the model being evaluated, and , , and 

are the discrepancy, the degrees of freedom, and the noncentrality parameter 
estimate for the baseline model.

The CFI is identical to McDonald and Marsh’s (1990) relative noncentrality index 
(RNI)

except that the CFI is truncated to fall in the range from 0 to 1. CFI values close to 1 
indicate a very good fit.

Note: Use the \cfi text macro to display the value of the comparative fit index in the 
output path diagram.

Parsimony Adjusted Measures

James, et al. (1982) suggested multiplying the NFI by a parsimony index so as to take 
into account the number of degrees of freedom for testing both the model being 
evaluated and the baseline model. Mulaik, et al. (1989) suggested applying the same 
adjustment to the GFI. Amos also applies a parsimony adjustment to the CFI.

See also “PGFI” on p. 655.
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PNFI

The PNFI is the result of applying James, et al.’s (1982) parsimony adjustment to the 
NFI

where d is the degrees of freedom for the model being evaluated, and  is the degrees 
of freedom for the baseline model.

Note: Use the \pnfi text macro to display the value of the parsimonious normed fit index 
in the output path diagram.

PCFI

The PCFI is the result of applying James, et al.’s (1982) parsimony adjustment to the 
CFI:

where d is the degrees of freedom for the model being evaluated, and  is the degrees 
of freedom for the baseline model.

Note: Use the \pcfi text macro to display the value of the parsimonious comparative fit 
index in the output path diagram.

GFI and Related Measures

The GFI and related fit measures are described here.

GFI

The GFI (goodness-of-fit index) was devised by Jöreskog and Sörbom (1984) for ML 
and ULS estimation, and generalized to other estimation criteria by Tanaka and Huba 
(1985). 
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The GFI is given by

where  is the minimum value of the discrepancy function defined in Appendix B and 
 is obtained by evaluating F with , g = 1, 2,...,G. An exception has to be 

made for maximum likelihood estimation, since (D2) in Appendix B is not defined for 
. For the purpose of computing GFI in the case of maximum likelihood 

estimation,  in Appendix B is calculated as

with , where  is the maximum likelihood estimate of . GFI is 
always less than or equal to 1. GFI = 1 indicates a perfect fit.

Note: Use the \gfi text macro to display the value of the goodness-of-fit index in the 
output path diagram.

AGFI

The AGFI (adjusted goodness-of-fit index) takes into account the degrees of freedom 
available for testing the model. It is given by

where

The AGFI is bounded above by 1, which indicates a perfect fit. It is not, however, 
bounded below by 0, as the GFI is.

Note: Use the \agfi text macro to display the value of the adjusted GFI in the output path 
diagram.
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PGFI

The PGFI (parsimony goodness-of-fit index), suggested by Mulaik, et al. (1989), is a 
modification of the GFI that takes into account the degrees of freedom available for 
testing the model

where d is the degrees of freedom for the model being evaluated, and

is the degrees of freedom for the baseline zero model.

Note: Use the \pgfi text macro to display the value of the parsimonious GFI in the 
output path diagram.

Miscellaneous Measures

Miscellaneous fit measures are described here.

HI 90

Amos reports a 90% confidence interval for the population value of several statistics. 
The upper and lower boundaries are given in columns labeled HI 90 and LO 90.

HOELTER

Hoelter’s (1983) critical N is the largest sample size for which one would accept the 
hypothesis that a model is correct. Hoelter does not specify a significance level to be 
used in determining the critical N, although he uses 0.05 in his examples. Amos reports 
a critical N for significance levels of 0.05 and 0.01. 
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Here are the critical N’s displayed by Amos for each of the models in Example 6:

Model A, for instance, would have been accepted at the 0.05 level if the sample 
moments had been exactly as they were found to be in the Wheaton study but with a 
sample size of 164. With a sample size of 165, Model A would have been rejected. 
Hoelter argues that a critical N of 200 or better indicates a satisfactory fit. In an analysis 
of multiple groups, he suggests a threshold of 200 times the number of groups. 
Presumably this threshold is to be used in conjunction with a significance level of 0.05. 
This standard eliminates Model A and the independence model in Example 6. Model B 
is satisfactory according to the Hoelter criterion. I am not myself convinced by 
Hoelter’s arguments in favor of the 200 standard. Unfortunately, the use of critical N 
as a practical aid to model selection requires some such standard. Bollen and Liang 
(1988) report some studies of the critical N statistic.

Note: Use the \hfive text macro to display Hoelter’s critical N in the output path diagram 
for , or the \hone text macro for .

LO 90

Amos reports a 90% confidence interval for the population value of several statistics. 
The upper and lower boundaries are given in columns labeled HI 90 and LO 90.

RMR

The RMR (root mean square residual) is the square root of the average squared amount 
by which the sample variances and covariances differ from their estimates obtained 
under the assumption that your model is correct.

Model HOELTER
0.05

HOELTER
0.01

Model A: No Autocorrelation 164 219
Model B: Most General 1615 2201
Model C: Time-Invariance 1925 2494
Model D: A and C Combined 216 277
Independence model 11 14
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The smaller the RMR is, the better. An RMR of 0 indicates a perfect fit.
The following output from Example 6 shows that, according to the RMR, Model A 

is the best among the models considered except for the saturated model:

Note: Use the \rmr text macro to display the value of the root mean square residual in 
the output path diagram.

Selected List of Fit Measures

If you want to focus on a few fit measures, you might consider the implicit 
recommendation of Browne and Mels (1992), who elect to report only the following fit 
measures:

“CMIN” on p. 639

“P” on p. 639

“FMIN” on p. 642

“F0” on p. 643, with 90% confidence interval

“PCLOSE” on p. 645

“RMSEA” on p. 643, with 90% confidence interval

“ECVI” on p. 647, with 90% confidence interval (See also “AIC” on p. 645)

For the case of maximum likelihood estimation, Browne and Cudeck (1989, 1993) 
suggest substituting MECVI (p. 648) for ECVI.

Model RMR GFI AGFI PGFI

Model A: No Autocorrelation 0.284 0.975 0.913 0.279
Model B: Most General 0.757 0.998 0.990 0.238
Model C: Time-Invariance 0.749 0.997 0.993 0.380
Model D: A and C Combined 0.263 0.975 0.941 0.418
Saturated model 0.000 1.000
Independence model 12.342 0.494 0.292 0.353
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Appendix

D
Numeric Diagnosis of 
Non-Identifiability

In order to decide whether a parameter is identified or an entire model is identified, 
Amos examines the rank of the matrix of approximate second derivatives and of some 
related matrices. The method used is similar to that of McDonald and Krane (1977). 
There are objections to this approach in principle (Bentler and Weeks, 1980; 
McDonald, 1982). There are also practical problems in determining the rank of a 
matrix in borderline cases. Because of these difficulties, you should judge the 
identifiability of a model on a priori grounds if you can. With complex models, this 
may be impossible, so you will have to rely on the numeric determination of Amos. 
Fortunately, Amos is pretty good at assessing identifiability in practice.





661

 
 

Appendix

E
Using Fit Measures to Rank Models

In general, it is hard to pick a fit measure because there are so many from which to 
choose. The choice gets easier when the purpose of the fit measure is to compare 
models to each other rather than to judge the merit of models by an absolute standard. 
For example, it turns out that it does not matter whether you use RMSEA, RFI, or TLI 
when rank ordering a collection of models. Each of those three measures depends on 

 and d only through , and each depends monotonically on . Thus, each 
measure gives the same rank ordering of models. For this reason, the specification 
search procedure reports only RMSEA.

The following fit measures depend on  and d only through , and they depend 
monotonically on . The specification search procedure reports only CFI as 
representative of them all.
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 (not reported by Amos)

The following fit measures depend monotonically on  and not at all on d. The 
specification search procedure reports only  as representative of them all.

Each of the following fit measures is a weighted sum of  and d and can produce a 
distinct rank order of models. The specification search procedure reports each of them 
except for CAIC.
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Cb
ˆ db–

-----------------–=

Ĉ
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Using Fit  Measures to Rank Models

Each of the following fit measures is capable of providing a unique rank order of 
models. The rank order depends on the choice of baseline model as well. The 
specification search procedure does not report these measures.

The following fit measures are the only ones reported by Amos that are not functions 
of  and d in the case of maximum likelihood estimation. The specification search 
procedure does not report these measures.

IFI 2=

PNFI

PCFI

Ĉ

GFI

AGFI
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Appendix

F
Baseline Models for Descriptive Fit 
Measures

Seven measures of fit (NFI, RFI, IFI, TLI, CFI, PNFI, and PCFI) require a null or 
baseline bad model against which other models can be compared. The specification 
search procedure offers a choice of four null, or baseline, models:

Null 1: The observed variables are required to be uncorrelated. Their means and 
variances are unconstrained. This is the baseline Independence model in an ordinary 
Amos analysis when you do not perform a specification search.

Null 2: The correlations among the observed variables are required to be equal. The 
means and variances of the observed variables are unconstrained.

Null 3: The observed variables are required to be uncorrelated and to have means of 0. 
Their variances are unconstrained. This is the baseline Independence model used by 
Amos 4.0.1 and earlier for models where means and intercepts are explicit model 
parameters.

Null 4: The correlations among the observed variables are required to be equal. The 
variances of the observed variables are unconstrained. Their means are required to be 0.

Each null model gives rise to a different value for NFI, RFI, IFI, TLI, CFI, PNFI, and 
PCFI. Models Null 3 and Null 4 are fitted during a specification search only when 
means and intercepts are explicitly estimated in the models you specify. The Null 3 
and Null 4 models may be appropriate when evaluating models in which means and 
intercepts are constrained. There is little reason to fit the Null 3 and Null 4 models in 
the common situation where means and intercepts are not constrained but are 
estimated for the sole purpose of allowing maximum likelihood estimation with 
missing data.

To specify which baseline models you want to be fitted during specification searches:
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E From the menus, choose Analyze Specification Search.

E Click the Options button  on the Specification Search toolbar.

E In the Options dialog, click the Next search tab.

The four null models and the saturated model are listed in the Benchmark models 
group.
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Appendix

G
Rescaling of AIC, BCC, and BIC

The fit measures, AIC, BCC, and BIC, are defined in Appendix C. Each measure is of 
the form , where k takes on the same value for all models. Small values are 
good, reflecting a combination of good fit to the data (small ) and parsimony 
(small q). The measures are used for comparing models to each other and not for 
judging the merit of a single model.

The specification search procedure in Amos provides three ways of rescaling these 
measures, which were illustrated in Examples 22 and 23. This appendix provides 
formulas for the rescaled fit measures. 

In what follows, let , , and  be the fit values for model i.

Zero-Based Rescaling

Because AIC, BCC, and BIC are used only for comparing models to each other, with 
smaller values being better than larger values, there is no harm in adding a constant, 
as in:

Ĉ kq+
Ĉ

AIC i  BCC i  BIC i 

AIC 0
i  AIC i  min

i
AIC i  –=

BCC 0
i  BCC i  min

i
BCC i  –=

BIC 0
i  BIC i  min

i
BIC i  –=
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The rescaled values are either 0 or positive. For example, the best model according to 
AIC has , while inferior models have positive  values that reflect how 
much worse they are than the best model.

E To display , , and  after a specification search, click  on the 
Specification Search toolbar.

E On the Current results tab of the Options dialog, click Zero-based (min = 0).

Akaike Weights and Bayes Factors (Sum = 1)

E To obtain the following rescaling, select Akaike weights and Bayes factors (sum = 1) on 
the Current results tab of the Options dialog.

Each of these rescaled measures sums to 1 across models. The rescaling is performed 
only after an exhaustive specification search. If a heuristic search is carried out or if a 
positive value is specified for Retain only the best ___ models, then the summation in 
the denominator cannot be calculated, and rescaling is not performed. The  are 
called Akaike weights by Burnham and Anderson (1998).  has the same 
interpretation as . Within the Bayesian framework and under suitable 
assumptions with equal prior probabilities for the models, the  are approximate 
posterior probabilities (Raftery, 1993, 1995).
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Rescaling of AIC, BCC, and BI C

Akaike Weights and Bayes Factors (Max = 1)

E To obtain the following rescaling, select Akaike weights and Bayes factors (max = 1) on 
the Current results tab of the Options dialog.

For example, the best model according to AIC has , while inferior models 
have  between 0 and 1. See Burnham and Anderson (1998) for further discussion 
of , and Raftery (1993, 1995) and Madigan and Raftery (1994) for further 
discussion of .
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Notices

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other 
countries. Consult your local IBM representative for information on the products and 
services currently available in your area. Any reference to an IBM product, program, or 
service is not intended to state or imply that only that IBM product, program, or service may 
be used. Any functionally equivalent product, program, or service that does not infringe any 
IBM intellectual property right may be used instead. However, it is the user's responsibility 
to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in 
this document. The furnishing of this document does not grant you any license to these 
patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A. 

For license inquiries regarding double-byte character set (DBCS) information, contact the 
IBM Intellectual Property Department in your country or send inquiries, in writing, to: 

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan
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The following paragraph does not apply to the United Kingdom or any other country 
where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS 
MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do 
not allow disclaimer of express or implied warranties in certain transactions, therefore, this 
statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new 
editions of the publication. IBM may make improvements and/or changes in the product(s) 
and/or the program(s) described in this publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only 
and do not in any manner serve as an endorsement of those Web sites. The materials at those 
Web sites are not part of the materials for this IBM product and use of those Web sites is at 
your own risk.

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: 
(i) the exchange of information between independently created programs and other programs 
(including this one) and (ii) the mutual use of the information which has been exchanged, 
should contact: 

IBM Software Group
Attention: Licensing
71 S Wacker Dr, 6th Floor.
Chicago, IL 60606
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in 
some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are 
provided by IBM under terms of the IBM Customer Agreement, IBM International Program 
License Agreement or any equivalent agreement between us.
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Notices

Information concerning non-IBM products was obtained from the suppliers of those 
products, their published announcements or other publicly available sources. IBM has not 
tested those products and cannot confirm the accuracy of performance, compatibility or any 
other claims related to non-IBM products. Questions on the capabilities of non-IBM 
products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal 
without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To 
illustrate them as completely as possible, the examples include the names of individuals, 
companies, brands, and products. All of these names are fictitious and any similarity to the 
names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not 
appear.

Trademarks
IBM, the IBM logo, and ibm.com, and SPSS are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions worldwide. Other 
product and service names might be trademarks of IBM or other companies. A current list of 
IBM trademarks is available on the Web at http://www.ibm.com/legal/copytrade.shtml.

AMOS is a trademark of Amos Development Corporation. 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft 
Corporation in the United States, other countries, or both.
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identification, 69, 72, 87, 106, 135, 143, 155, 238
improve by adding new constraints, 113
independence, 285, 288, 320, 637
just-identified, 75
measurement, 86, 318
modification, 107
naming variables in, 12
nested, 269
new, 10
nonrecursive, 79, 133, 135
recursive, 79
regression, 9
rejection of, 106
saturated, 75, 285, 288, 320, 637
simple, 638
simultaneous equations, 181
specification, 39
specify, 11
stable, 139
structural, 87
test one against another, 99
unstable, 139
without means and intercepts, 382
zero, 637

model specification, non-graphical, 597
model-based imputation, 478
models

individual, view graphics for, 123
multiple in a single analysis, 119
multiple, view statistics for, 123

modification indices, 107, 113, 400
misuse of, 113
request, 156
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move objects, 15
multiple imputation, 478
multiple models in a single analysis, 119
multiple-group analysis, 395
multiple-group factor analysis, 381
multiply imputed data file, combining results, 487
multiply imputed datasets, 485
multivariate analysis of variance, 225

naming
groups, 205
variables, 26

NCP, noncentrality parameter, 642
negative variances, 159
nested models, 269
new group, 58, 79, 178
NFI, normed fit index, 649
NNFI, non-normed fit index, 651
non-diffuse prior distribution, 429
non-graphical model specification, 597
non-identifiability, 659
nonrecursive model, 79, 133, 135
normal distribution, 36
NPAR, number of parameters, 638
null model, 665
numeric custom estimands, 463

Observed
pd method for drawing path diagrams, 600

obtain
critical rations for parameter differences, 189
squared multiple correlations, 137
standardized estimates, 137, 146

Occam’s window, symmetric, 349
optional output, 16, 34, 50, 124
ordered-categorical data, 507

P, probability, 639
pairwise deletion, 282
parameter constraints, 43

parameter estimation
structure specification, 81

parameters
affected by cross-group constraints, 384
equal, benefits of specifying, 46
specifying equal, 45

parsimony, 638
parsimony index, 652
Path

pd method for drawing path diagrams, 602
path diagram, 3

alter the appearance, 15
attach data file, 24, 48
constrain parameters, 14
copy, 21
create, 89
delete an object, 15
display chi-square statistics, 55
draw arrows, 13
duplicate measurement model, 90
format objects, 47
move objects, 15, 47
new, 24
print, 21
redo an action, 16
reshape an object, 15
rotate indicators, 90
specify group name in caption, 183
undo an action, 16

PCFI, parsimonious comparative fit index, 653
PCLOSE, for close fit of the population RMSEA, 

645
pd methods

Caption, 603
Cov, 602
GetCheckBox, 608
Observed, 600
Path, 602
Reposition, 602
SetDataFile, 608
UndoResume, 603
UndoToHere, 603
Unobserved, 601

PGFI, parsimony goodness-of-fit index, 655
Plot window

display best-fit graphs, 358
scree plot, 359

PNFI, parsimonious normed fit index, 653
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point of diminishing returns, 350, 357, 360
population discrepancy

measure of model adequacy, 642
posterior

distribution, 403
mean, 404
standard deviation, 404

posterior predictive distribution, 498, 526, 555, 572, 
592

for a latent variable, 530
PRATIO, parsimony ratio, 639
predictive distribution. See posterior predictive dis-

tribution
predictor variables, 37
prior distribution, 403, 405, 429

of group proportions, 595
probability, 31

random number seed, 410
random variables, 36
recoding data, 493, 510, 531
recursive model, 79
regression imputation, 477
regression model, 9, 14, 495
regression weights

fix, 72
making optional, 369
unidentified, 75

Reposition
pd method for drawing path diagrams, 602

request modification indices, 156
rescaled measures, 667
reshape an object, 15
RFI, relative fit index, 650
RMR, root mean square residual, 656
RMSEA, root mean square error of approximation, 

643
RNI, relative noncentrality index, 652
rotate indicators, 90

saturated model, 75, 285, 288, 320, 637
scatterplot

adjusting line of constant fit, 353
adjusting line representing C - df, 355
line representing C - df, 354
line representing constant fit, 353
of fit and complexity, 351
other lines representing constant fit, 356

scree plot, 360
for C, 359

seed, random number, 410
Semnet, 5
SetDataFile

pd method, 608
simple model, 638
simultaneous analysis of several groups, 165
simultaneous equations model, 181
simultaneous factor analysis, 203
SLS, scale-free least squares, 635
space vertically, 197
specification search, 337–366

Akaike weights, 345
CAIC, 662
CFI, 661
comparing models using Bayes factor, 348
comparing models using BCC, 344
comparing models using BIC, 346
confirmatory, 338
exploratory factor analysis, 362, 367
generated models, 343
heuristic, 367, 376
increasing speed of, 341
limiting models retained, 341
number of parameters to use, 350
optional arrows, 363
parameter estimates, 343
performing, 342
point of diminishing returns, 350
program options, 340
required arrows, 339
resetting defaults, 340, 363
RMSEA, 661
viewing fit measures, 342
with few optional arrows, 338



693

Index

specify
benefits of equal parameters, 46
equal paramaters, 45
group name in figure caption, 183

specifying group differences
conventions, 167

squared multiple correlation, 148
stability index, 139
stability test in Bayesian estimation, 440
stable model, 139
standardized estimates, 34, 136

obtain, 146
view, 147

statistical hypothesis testing, 106
stochastic regression imputation, 477
structural covariances, 383
structural equation modeling, 2

journals, 4
methods for estimating, 2

structural model, 87
structure specification, 59, 81

parameter estimation, 81
survival time, 492
symettric Occam’s window, 349

test for uncorreletated variables, 62
testing hypotheses about means, 217
text file with results, 58
text macros, 54, 638–657
text output

copy, 21
thinning, 434
thresholds. See category boundaries
time-series plot, 420
TLI, Tucker-Lewis index, 651
total effect, 127
trace plot, 420, 523, 575
training data, 541

ULS, unweighted least squares, 635
unbiased estimates of variance and covariances, 250
uncorrelated variables, 62
UndoResume

pd method, 603
UndoToHere

pd method, 603
unidentified regression weights, 75
unique factor, 143
unique variables, 80
Unobserved

pd method for drawing path diagrams, 601
unobserved variables, 83
unstable model, 139
using BCC to compare models, 372

variables
endogenous, 71, 78
entering names, 92
exogenous, 71, 78, 80
unique, 80
unobserved, 83

variances
label, 198
unbiased estimates, 250

view
generated models, 385
graphics output, 20, 29
parameter subsets, 384
standardized estimates, 147
standardized indirect effects, 447
text output, 19, 30

zero model, 637
zero-based rescaling, 667




